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1 Product Overview

Why Use This Toolbox?

1-2

System Identification Toolbox software lets you estimate linear and nonlinear
mathematical models of dynamic systems from measured data. Use the
resulting models for analyzing system dynamics, simulating the output of

a system for a given input, predicting future outputs based on previous
observations of inputs and outputs, or for control design.

System identification is especially helpful for modeling systems that you
cannot easily model from first principles or specifications, such as engine
subsystems, thermofluid processes, and electromechanical systems. Such
black-box models can simplify detailed first-principle models, such as
finite-element models of structures and flight dynamics models, by fitting
simpler models to their simulated responses.

You can also use System Identification Toolbox functions to compute the
coefficients of ordinary differential and difference equations for systems
modeled from first principles. Such models are called grey-box models.

For real-time applications in adaptive control, adaptive filtering, or adaptive
prediction, you can use this product to perform recursive parameter
estimation.



Related Products

Related Products

The following table summarizes MathWorks® products that extend and
complement the System Identification Toolbox software. For current
information about these and other MathWorks products, point your Web
browser to:

www.mathworks.com

Product Description

Control System Toolbox™ Provides extensive tools to analyze
plant models created in the System
Identification Toolbox software and
to tune control systems based on
these plant models.

Model Predictive Control Toolbox™ | Uses the linear plant models
created in the System Identification
Toolbox software for predicting plant
behavior that is optimized by the
model-predictive controller.

Neural Network Toolbox™ Provides flexible neural-network
structures for estimating nonlinear
models using the System
Identification Toolbox software.

Optimization Toolbox™ When this toolbox is installed,
you have the option of using

the 1sgnonlin optimization
algorithm for linear and nonlinear
identification.

Robust Control Toolbox™ Provides tools to design
multiple-input and multiple-output
(MIMO) control systems based on
plant models created in the System
Identification Toolbox software.
Helps you assess robustness based
on confidence bounds for the
identified plant model.
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1 Product Overview

Product

Description

Signal Processing Toolbox™

Provides additional options for:

¢ Filtering
(The System Identification
Toolbox software provides only
the fifth-order Butterworth filter.)

® Spectral analysis

After using the advanced data
processing capabilities of the Signal
Processing Toolbox software, you
can import the data into the System
Identification Toolbox software for
modeling.

Simulink®

Provides System Identification
blocks for simulating the models
you identified using the System
Identification Toolbox software. Also
provides blocks for model estimation.




Documentation

Documentation
System Identification Toolbox documentation includes:

® Getting Started Guide — Summarizes the capabilities of the System
Identification Toolbox software and provides an overview of system
identification. Step-by-step tutorials walk you through the most common
System Identification Toolbox tasks.

® User’s Guide — Describes the various tasks of using the System
Identification Toolbox software.

e Reference — Describes System Identification Toolbox commands.
® Release Notes — Describes important changes in the current product

version and compatibility considerations.

View the documentation online from the Help menu on the MATLAB®
desktop.
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About System Identification

¢ “What Is System Identification?” on page 2-2

¢ “About Dynamic Systems and Models” on page 2-3

® “System Identification Requires Measured Data” on page 2-7
¢ “Building Models from Data” on page 2-10

¢ “Black-Box Modeling” on page 2-13

® “Grey-Box Modeling” on page 2-18

¢ “Evaluating Model Quality” on page 2-20

¢ “Learn More” on page 2-24
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What Is System Identification?

System identification 1s a methodology for building mathematical models
of dynamic systems using measurements of the system’s input and output
signals.

The process of system identification requires that you:

e Measure the input and output signals from your system in time or
frequency domain.

® Select a model structure.

® Apply an estimation method to estimate value for the adjustable
parameters in the candidate model structure.

e Evaluate the estimated model to see if the model is adequate for your
application needs.



About Dynamic Systems and Models

About Dynamic Systems and Models

In this section...
“What Is a Dynamic Model?” on page 2-3

“Continuous-Time Dynamic Model Example” on page 2-4

“Discrete-Time Dynamic Model Example” on page 2-5

What Is a Dynamic Model?

In a dynamic system, the values of the output signals depend on both the
Iinstantaneous values of its input signals and also on the past behavior of the
system. For example, a car seat is a dynamic system—the seat shape (settling
position) depends on both the current weight of the passenger (instantaneous
value) and how long this passenger has been riding in the car (past behavior).

A model 1s a mathematical relationship between a system’s input and output
variables. Models of dynamic systems are typically described by differential
or difference equations, transfer functions, state-space equations, and
pole-zero-gain models.

You can represent dynamic models both in continuous-time and discrete-time
form.

An often-used example of a dynamic model is the equation of motion of a
spring-mass-damper system. As shown in the next figure, the mass moves in
response to the force F(¢) applied on the base to which the mass is attached.
The input and output of this system are the force F(f) and displacement y()
respectively.

2-3
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F(t)

,—» y(t)

N

Mass-Spring-Damper System Excited by Force F(t)

Continuous-Time Dynamic Model Example

You can represent the same physical system as several equivalent models.
For example, you can represent the mass-spring-damper system in continuous
time as a second order differential equation:

d®y dy
mﬁ‘i‘CE‘Fky(t):F(t)

where m is the mass, k the spring’s stiffness constant, and ¢ the damping
coefficient. The solution to this differential equation lets you determine the
displacement of the mass, y(¢), as a function of external force F(¢) at any time ¢
for known values of constant m, ¢ and k.

If you treat displacement y(¢) and velocity v() = % as state variables, you can

express the previous equation of motion as a state-space model of the system:

av _ AY )+ BF ()
dt

y(@&) =CY(¢)

where Y(¢) = [y(?);v(t)] is a vector of model states. The matrices A, B, and C
are related to the constants m, ¢ and k as follows:

A=1[01; -k/m —c/m]
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B = [0; 1/m]
C=1[10]

You can also obtain a transfer function model of the spring-mass-damper
system by taking the Laplace transform of the differential equation:

_Y() 1

G(s) = =
° F(s) (ms2 +cs+k)

where s is the Laplace variable.

Discrete-Time Dynamic Model Example

Suppose you can only observe the input and output variables F(¢) and y(f)

of the mass-spring-damper system at discrete time instants ¢ = nT, where
T, is a fixed time interval and n =0, 1, 2, .... The variables are said to be
sampled with sampling interval T. Then, you can represent the relationship
between the sampled input-output variables as a second order difference
equation, such as:

y&) + a1yt —T,) +agyt —2T,) =bF(t - Ty)

Often, for simplicity, 7 is taken as one time unit, and the equation can be
written as:

y@&) + a1yt -D+agyt—-2)=bF(t-1)

where a, and a, are the model parameters. The model parameters are related
to the system constants m, ¢, and k, and the sampling interval 7.

This difference equation shows the dynamic nature of the model. The
displacement value at the time instant ¢ depends not only on the value of
force F at a previous time instant, but also on the displacement values at the
previous two time instants y(t—1) and y(t—2).

You can use this equation to compute the displacement at a specific time.

The displacement is represented as a weighted sum of the past input and
output values:

2-5
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yt)=bFt-1)—a1y(t-1)—agy(t—2)

This equation shows an iterative way of generating values of output y(t)
starting from initial conditions (y(0) and y(I)) and measurements of input F(?).
This computation is called simulation.

Alternatively, the output value at a given time ¢ can be computed using the
measured values of output at previous two time instants and the input value
at a previous time instant. This computation is called prediction. For more
information on simulation and prediction using a model, see “Simulating and
Predicting Model Output” in the User’s Guide.

You can also represent a discrete-time equation of motion in state-space and
transfer-function forms by performing the transformations similar to those
described in “Continuous-Time Dynamic Model Example” on page 2-4.
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System ldentification Requires Measured Data

In this section...

“Why Does System Identification Require Data?” on page 2-7
“Time Domain Data” on page 2-7
“Frequency Domain Data” on page 2-8

“Data Quality Requirements” on page 2-8

“Data Representation in This Toolbox” on page 2-9

Why Does System Identification Require Data?

System identification uses the input and output signals you measure from
a system to estimate the values of adjustable parameters in a given model
structure.

Using this toolbox, you build models using time-domain input-output signals,
frequency response data, time series signals, and time-series spectra.

Obtaining a good model of your system depends on how well your measured
data reflects the behavior of the system. See “Data Quality Requirements”
on page 2-8.

Time Domain Data

Time-domain data consists of the input and output variables of the system
that you record at a uniform sampling interval over a period of time.

For example, if you measure the input force F(f) and mass displacement x(¢) of

the spring-mass-damper system at a uniform sampling frequency of 10 Hz,
you obtain the following vectors of measured values:

Ueas = F(T), F(2T,), F(3T,),..., F(NT,)]
Ymeas = 2(Ts), x(2T), x(3T),..., x(NT,)]

where T = 0.1 seconds and N7, is time of the last measurement.
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If you want to build a discrete-time model from this data, the data vectors
U, @and v, and the sampling interval T’ provide sufficient information for
creating such a model.

If you want to build a continuous-time model, you should also know the
intersample behavior of the input signals during the experiment. For
example, the input may be piecewise constant (zero-order hold) or piecewise
linear (first-order hold) between samples.

Frequency Domain Data

Frequency domain data represents measurements of the system input and
output variables that you record or store in the frequency domain. The
frequency domain signals are Fourier transforms of the corresponding time
domain signals.

Frequency domain data can also represent the frequency response of the
system, represented by the set of complex response values over a given
frequency range. The frequency response describes the outputs to sinusoidal
inputs. If the input is a sine wave with frequency w, then the output is also
a sine wave of the same frequency, whose amplitude is A(®) times the input
signal amplitude and a phase shift of ®(w) with respect to the input signal.
The frequency response is A(w)ef®®),

In case of mass-spring-damper system, you can obtain the frequency response
data by using a sinusoidal input force and measuring the corresponding
amplitude gain and phase shift of the response, over a range of input
frequencies.

You can use frequency-domain data to build both discrete-time and
continuous-time models of your system.

Data Quality Requirements

System identification requires that your data capture the important dynamics
of your system. Good experimental design ensures that you measure the right
variables with sufficient accuracy and duration to capture the dynamics you
want to model. In general, your experiment must:
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Use inputs that excite the system dynamics adequately. For example, a
single step is seldom enough excitation.

Measure data long enough to capture the important time constants.

Set up data acquisition system to have good signal-to-noise ratio.

Measure data at appropriate sampling intervals or frequency resolution.

You can analyze the data quality before building the model using techniques
available in the Signal Processing Toolbox software. For example, analyze
the input spectra to determine if the input signals have sufficient power over
the bandwidth of the system.

You can also analyze your data to determine peak frequencies, input

delays, important time constants, and indication of nonlinearities using
non-parametric analysis tools in this toolbox. You can use this information for
configuring model structures for building models from data. See the following
User’s Guide topics:

e “Identifying Impulse-Response Models”
e “Identifying Frequency-Response Models”

Data Representation in This Toolbox

If you build models using the System Identification Tool GUI, you must
import your data into the GUI.

If you use the command-line interface, specify your data using iddata
and idfrd objects. These objects conveniently store data values and other
information about the data, such as its sampling interval and intersample

behavior.

For more information, see “Data Import and Processing” in the User’s Guide.

2-9
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Building Models from Data

In this section...

“System Identification Requires a Model Structure” on page 2-10
“How the Toolbox Computes Model Parameters” on page 2-11

“Configuring the Parameter Estimation Algorithm” on page 2-11

System Identification Requires a Model Structure

A model structure is a mathematical relationship between input and output
variables that contains unknown parameters. Examples of model structures
are transfer functions with adjustable poles and zeros, state space equations
with unknown system matrices, and nonlinear parameterized functions.

The following difference equation represents a simple model structure:

y(k) + ay(k—1) = bu(k)

where a and b are adjustable parameters.

The system identification process requires that you choose a model structure
and apply the estimation methods to determine the numerical values of the
model parameters.

You can use one of the following approaches to choose the model structure:

® You want a model that is able to reproduce your measured data and is as
simple as possible. You can try various mathematical structures available
in the toolbox. This modeling approach is called black-box modeling.

® You want a specific structure for your model, which you may have derived
from first principles, but do not know numerical values of its parameters.
You can then represent the model structure as a set of equations or
state-space system in MATLAB and estimate the values of its parameters
from data. This approach is known as grey-box modeling.
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How the Toolbox Computes Model Parameters

The System Identification Toolbox software estimates model parameters by
minimizing the error between the model output and the measured response.
The output y,,,,; of the linear model is given by:

mode.
ymodel(t) = Gu(t)
where G is the transfer function.

To determine G, the toolbox minimizes the difference between the model
output y_ ..t and the measured output y, .. (t). The minimization criterion
is a weighted norm of the error v(¢), where:

U(t) = ymeas(t) - ymodel(t) = ymeas(t) - Gu(t)
Ymodel) 18 one of the following:

¢ Simulated response of the model for a given input w(z).

¢ Predicted response of the model for a given input u(¢) and past
measurements of output (v,,,..(t-1), ¥,,00sE-2)s--.).

Accordingly, the error v(?) is called simulation error or prediction error. The
estimation algorithms adjust parameters in the model structure G such that
the norm of this error is as small as possible.

Configuring the Parameter Estimation Algorithm

You can configure the estimation algorithm by:

¢ Configuring the minimization criterion to focus the estimation in a desired
frequency range, such as put more emphasis at lower frequencies and
deemphasize higher frequency noise contributions. You can also configure
the criterion to target the intended application needs for the model such
as simulation or prediction.

® Specifying optimization options for iterative estimation algorithms.

The majority of estimation algorithms in this toolbox are iterative. You can
configure an iterative estimation algorithm by specifying options, such as
the optimization method and the maximum number of iterations.

2-11
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For more information about configuring the estimation algorithm, see the
topics for estimating specific model structures in the System Identification
Toolbox User’s Guide.
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Black-Box Modeling

In this section...

“Selecting Black-Box Model Structure and Order” on page 2-13
“When to Use Nonlinear Model Structures?” on page 2-15
“Black-Box Estimation Example” on page 2-15

Selecting Black-Box Model Structure and Order

Black-box modeling is useful when your primary interest is in fitting the data
regardless of a particular mathematical structure of the model. The toolbox
provides several linear and nonlinear black-box model structures, which have
traditionally been useful for representing dynamic systems. These models
structures vary in complexity depending on the flexibility you need to account
for the dynamics and noise in your system. You can choose one of these
structures and compute its parameters to fit the measured response data.

Black-box modeling is usually a trial-and-error process, where you estimate
the parameters of various structures and compare the results. Typically, you
start with the simple linear model structure and progress to more complex
structures. You might also choose a model structure because you are more
familiar with this structure or because you have specific application needs.

The simplest linear black-box structures require the fewest options to
configure:

¢ Linear ARX model, which is the simplest input-output polynomial model.
® State-space model, which you can estimate by specifying the number of

model states

Estimation of these structures also uses noniterative estimation algorithms,
which further reduces complexity.

You can configure a model structure using the model order. The definition of

model order varies depending on the type of model you select. For example, if
you choose a transfer function representation, the model order is related to the
number of poles and zeros. For state-space representation, the model order
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corresponds to the number of states. In some cases, such as for linear ARX and
state-space model structures, you can estimate the model order from the data.

If the simple model structures do not produce good models, you can select
more complex model structures by:

® Specifying a higher model order for the same linear model structure.
Higher model order increases the model flexibility for capturing complex
phenomena. However, unnecessarily high orders can make the model less
reliable.

¢ Explicitly modeling the noise:
Y(O=Gu(t)+He(?)

where H models the additive disturbance by treating the disturbance as
the output of a linear system driven by a white noise source e(?).

Using a model structure that explicitly models the additive disturbance can
help to improve the accuracy of the measured component G. Furthermore,
such a model structure is useful when your main interest is using the model
for predicting future response values.

e Using a different linear model structure.
See “Linear Model Structures” in the User’s Guide.
e Using a nonlinear model structure.

Nonlinear models have more flexibility in capturing complex phenomena
than linear models of similar orders. See “Nonlinear Model Structures”
in User’s Guide.

Ultimately, you choose the simplest model structure that provides the best
fit to your measured data. For more information, see Chapter 4, “Tutorial —
Identifying Linear Models Using the GUTI”.

Regardless of the structure you choose for estimation, you can simplify the
model for your application needs. For example, you can separate out the
measured dynamics (G) from the noise dynamics (H) to obtain a simpler model
that represents just the relationship between y and u. You can also convert
an estimated model into an linear time-invariant (LTI) object and linearize a
nonlinear model about an operating point.



Black-Box Modeling

When to Use Nonlinear Model Structures?

A linear model is often sufficient to accurately describe the system dynamics
and, in most cases, you should first try to fit linear models. If the linear model
output does not adequately reproduce the measured output, you might need
to use a nonlinear model.

You can assess the need to use a nonlinear model structure by plotting the
response of the system to an input. If you notice that the responses differ
depending on the input level or input sign, try using a nonlinear model. For
example, if the output response to an input step up is faster than the response
to a step down, you might need a nonlinear model.

Before building a nonlinear model of a system that you know is nonlinear,
try transforming the input and output variables such that the relationship
between the transformed variables is linear. For example, consider a system
that has current and voltage as inputs to an immersion heater, and the
temperature of the heated liquid as an output. The output depends on the
inputs via the power of the heater, which is equal to the product of current
and voltage. Instead of building a nonlinear model for this two-input and
one-output system, you can create a new input variable by taking the product
of current and voltage and then build a linear model that describes the
relationship between power and temperature.

If you cannot determine variable transformations that yield a linear
relationship between input and output variables, you can use nonlinear
structures such as Nonlinear ARX or Hammerstein-Wiener models. For
a list of supported nonlinear model structures and when to use them, see
“Nonlinear Model Structures” in User’s Guide.

Black-Box Estimation Example

You can use the GUI or commands to estimate linear and nonlinear models of
various structures. In most cases, you choose a model structure and estimate
the model parameters using a single command.

Consider the mass-spring-damper system, described in “About Dynamic
Systems and Models” on page 2-3. If you do not know the equation of motion
of this system, you can use a black-box modeling approach to build a model.
For example, you can estimate transfer functions or state-space models by
specifying the orders of these model structures.
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A transfer function is a ratio of polynomials:

(bo +by s+ bys? +)
(1 +fis+ f232 + )

G(s) =

In discrete-time, the transfer function of the mass-spring-damper system
can be:
bz!

G(z1)=
° (1+ A2+ f272)

where the model orders correspond to the number of coefficients of the
numerator and the denominator (nb = 1 and nf = 2) and the input-output
delay equals the lowest order exponent of z! in the numerator (nk = 1).

You can build a linear black-box model of a mass-spring-damper system using
an Output Error structure using the following command:

m = oe(data, [1 2 1])

where data is your measured input-output data, represented as an iddata
object and the model order is [nb nf nk] =[1 2 1]. Usually, you do not know
the model orders in advance. You should try several model order values until
you find the orders that produce an acceptable model.

Alternatively, you can choose a state-space structure to represent the
mass-spring-damper system and estimate the model parameters using the
n4sid command:

m = n4sid(data, 2)

where order = 2 represents the number of states in the model.

In black-box modeling, you do not need the system’s equation of motion—only
a guess of the model orders.



Black-Box Modeling

For more information about building models, see “Steps for Using the System
Identification Tool GUI” and “Commands for Model Estimation” in the User’s
Guide.
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Grey-Box Modeling

In some situations, you can deduce the model structure from physical
principles. For example, the mathematical relationship between the input
force and the resulting mass displacement in the mass-spring-damper system
is well known. In state-space form, the model is given by:

av _ AY )+ BF ()
dt

y(@) =CY (@)

where Y(t) = [y(t);v(t)] is the state vector. The coefficients A, B, and C are
functions of the model parameters:

A =10 1; —k/m —c/m]
B =1[0; 1/m]
C=1[10]

Here, you fully know the model structure but do not know the values of its
parameters—m, ¢ and k.

In the grey-box approach, you use the data to estimate the values of the
unknown parameters of your model structure. You specify the model structure
by a set of differential or difference equations in MATLAB and provide some
initial guess for the unknown parameters specified.

In general, you build grey-box models by:

1 Creating a template model structure.

2 Configuring the model parameters with initial values and constraints (if
any).

3 Applying an estimation method to the model structure and computing the
model parameter values.



Grey-Box Modeling

The following table summarizes the ways you can specify a grey-box model

structure.

Grey-Box Structure
Representation

Learn More in the User’s Guide

Represent the state-space model
structure as a structured idss model
object and estimate the state-space
matrices A, B and C.

You can compute the parameter

values, such as m, ¢, and &, from
the state space matrices A and B.
For example, m = 1/B(2) and k =
-A@2,1)m.

e “How to Estimate State-Space
Models with Canonical
Parameterization”

e “How to Estimate State-Space
Models with Structured
Parameterization”

Represent the state-space model
structure as an idgrey model object.
You can directly estimate the values
of parameters m, ¢ and k.

“ODE Parameter Estimation
(Grey-Box Modeling)”
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Evaluating Model Quality

In this section...

“How to Evaluate and Improve Model Quality” on page 2-20
“Comparing Model Response to Measured Response” on page 2-20
“Analyzing Residuals” on page 2-22

“Analyzing Model Uncertainty” on page 2-22

How to Evaluate and Improve Model Quality

After you estimate the model, you can evaluate the model quality by:

® “Comparing Model Response to Measured Response” on page 2-20
® “Analyzing Residuals” on page 2-22
¢ “Analyzing Model Uncertainty” on page 2-22

Ultimately, you must assess the quality of your model based on whether the
model adequately addresses the needs of your application. For information
about other available model analysis techniques, see Model Analysis in the
User’s Guide.

If you do not get a satisfactory model, you can iteratively improve your results
by trying a different model structure, changing the estimation algorithm
settings, or performing additional data processing. For more information
about estimating each type of model structure, see the User’s Guide. If
these changes do not improve your results, you might need to revisit your
experimental design and data gathering procedures.

Comparing Model Response to Measured Response

Typically, you evaluate the quality of a model by comparing the model
response to the measured output for the same input signal.

Suppose you use a black-box modeling approach to create dynamic models
of the spring-mass damper system. You try various model structures and
orders, such as:



Evaluating Model Quality

modell = arx(data, [2 1 1]);
model2 n4sid(data, 3)

You can simulate these models with a particular input and compare their
responses against the measured values of the displacement for the same input
applied to the real system. The following figure compares the simulated and
measured responses for a step input.

Model Cutput ws. Measured Displacement

Z; measured
35 rodeld; fit: B4.67% [
rnodel2; fit: 23.07%
Atk
2.5+
= 2r
-
1.5+
1k
&+
0
nz2 0.4 0a na i 1.2 1.4
Time [sec)

The previous figure indicates that model2 is better than model1 because
model2 better fits the data (65% vs. 83%).

The % fit indicates the agreement between the model response and the
measured output: 100 means a perfect fit, and 0 indicates a poor fit (that is,
the model output has the same fit to the measured output as the mean of
the measured output).
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For more information, see “Simulating and Predicting Model Output” in the
User’s Guide.

Analyzing Residuals

The System Identification Toolbox software lets you perform residual analysis
to assess the model quality. Residuals represent the portion of the output
data not explained by the estimated model. A good model has residuals
uncorrelated with past inputs.

For more information, see “Residual Analysis” in the User’s Guide.

Analyzing Model Uncertainty

When you estimate the model parameters from data, you obtain their nominal
values that are accurate within a confidence region. The size of this region is
determined by the values of the parameter uncertainties computed during
estimation. The magnitude of the uncertainties provide a measure of the
reliability of the model. Large uncertainties in parameters can result from
unnecessarily high model orders, inadequate excitation levels in the input
data, and poor signal-to-noise ratio in measured data.

You can compute and visualize the effect of parameter uncertainties on
the model response in time and frequency domains using pole-zero maps,
Bode response, and step response plots. For example, in the following Bode
plot of an estimated model, the shaded regions represent the uncertainty
in amplitude and phase of model’s frequency response, computed using the
uncertainty in the parameters. The plot shows that the uncertainty is low
only in the 5 to 50 rad/s frequency range, which indicates that the model is
reliable only in this frequency range.
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From F(t) to i)
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For more information, see “Computing Model Uncertainty” in the User’s
Guide.
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Learn More

The System Identification Toolbox documentation provides you with the
necessary information to use this product. Additional resources are available
to help you learn more about specific aspects of system identification theory
and applications.

The following book describes methods for system identification and physical
modeling:

Ljung, L., and T. Glad. Modeling of Dynamic Systems. PTR Prentice Hall,
Upper Saddle River, NdJ, 1994.

These books provide detailed information about system identification theory
and algorithms:

¢ Ljung, L. System Identification: Theory for the User. Second edition. PTR
Prentice Hall, Upper Saddle River, NJ, 1999.

e Siéderstrom, T., and P. Stoica. System Identification. Prentice Hall
International, London, 1989.

For information about working with frequency-domain data, see the following
book:

Pintelon, R., and J. Schoukens. System Identification. A Frequency Domain
Approach. Wiley-IEEE Press, New York, 2001.

For information on nonlinear identification, see the following references:

® Sjoberg, d., Q. Zhang, L. Ljung, A. Benveniste, B. Deylon, P. Glorennec, H.
Hjalmarsson, and A. Juditsky, “Nonlinear Black-Box Modeling in System
Identification: a Unified Overview.” Automatica. Vol. 31, Issue 12, 1995,
pp. 1691-1724.

e Juditsky, A., H. Hjalmarsson, A. Benveniste, B. Delyon, L. Ljung,
dJ. Sjoberg, and Q. Zhang, “Nonlinear Black-Box Models in System
Identification: Mathematical Foundations.” Automatica. Vol. 31, Issue 12,
1995, pp. 1725-1750.

e Zhang, Q., and A. Benveniste, “Wavelet networks.” IEEE Transactions on
Neural Networks. Vol. 3, Issue 6, 1992, pp. 889-898.



Learn More

e Zhang, Q., “Using Wavelet Network in Nonparametric Estimation.” IEEE
Transactions on Neural Networks. Vol. 8, Issue 2, 1997, pp. 227-236.

For more information about systems and signals, see the following book:
Oppenheim, J., and Willsky, A.S. Signals and Systems. PTR Prentice Hall,
Upper Saddle River, NJ, 1985.

The following textbook describes numerical techniques for parameter

estimation using criterion minimization:

Dennis, J.E., Jr., and R.B. Schnabel. Numerical Methods for Unconstrained
Optimization and Nonlinear Equations. PTR Prentice Hall, Upper Saddle
River, NJ, 1983.
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¢ “When to Use the GUI Versus the Command Line” on page 3-2
e “Starting This Toolbox” on page 3-3

e “Steps for Using This Toolbox” on page 3-4

¢ “Commands for Model Estimation” on page 3-6

e “Tutorials to Help You Get Started” on page 3-7



3 Using This Product

When to Use the GUI Versus the Command Line

New users should start by using the System Identification Tool GUI to become
familiar with the product.

You can work either in the GUI or at the command line to preprocess data,
and estimate, validate, and compare models.

The following operations are available only at the command line:

® Generating input and output data (see idinput).

e Estimating coefficients of linear and nonlinear ordinary differential or
difference equations (grey-box models).

¢ Using recursive online estimation methods. See topics about estimating
linear models recursively in the System Identification Toolbox User’s Guide.

¢ Converting between continuous-time and discrete-time models (see c2d
and d2c reference pages).

¢ Converting models to Control System Toolbox LTI objects (see the ss, tf,
and zpk reference pages).

Note Conversions to LTI objects require the Control System Toolbox
software.

Tip To learn more about estimating and validating models at the command
line, see Chapter 6, “Tutorial — Identifying Linear Models Using the
Command Line”.




Starting This Toolbox

Starting This Toolbox

After installing the System Identification Toolbox product, you can start the
System Identification Tool GUI or work at the command line.

For information about whether to use the GUI or the command line, see
“When to Use the GUI Versus the Command Line” on page 3-2.

To open the System Identification Tool GUI:

® Select Start > Toolboxes > System Identification > System
Identification Tool from the MATLAB desktop.

Alternatively, you can open the System Identification Tool GUI by typing the
following command in the MATLAB Command Window:

ident

To work at the command line, type the commands directly in the MATLAB
Command Window. For more information about supported commands, see
the reference pages.
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Steps for Using This Toolbox

System identification is an iterative process, where you identify models with
different structures from data and compare model performance. Ultimately,
you choose the simplest model that best describes the dynamics of your
system.

Because this toolbox lets you estimate different model structures quickly, you
should try as many different structures as possible to see which one produces
the best results.

A system identification workflow might include the following tasks:

1 Process data for system identification by:

Importing data into the MATLAB workspace.

Representing data in the System Identification Tool GUI or as an iddata
or idfrd object in the MATLAB workspace.

Plotting data to examine both time- and frequency-domain behavior.

To analyze the data for the presence of constant offsets and trends,
delay, feedback, and signal excitation levels, you can also use the advice
command.

Preprocessing data by removing offsets and linear trends, interpolating
missing values, filtering to emphasize a specific frequency range, or
resampling (interpolating or decimating) using a different time interval.

2 Identify linear or nonlinear models:

Frequency-response models
Impulse-response models

Low-order transfer functions (process models)
Input-output polynomial models

State-space models

Nonlinear black-box models

Ordinary difference or differential equations (grey-box models)



Steps for Using This Toolbox

3 Validate models.

When you do not achieve a satisfactory model, try a different model
structure and order or try another identification algorithm. In some cases,
you can improve results by including a noise model.

You might need to preprocess your data before doing further estimation.
For example, if there is too much high-frequency noise in your data, you
might need to filter or decimate (resample) the data before modeling.

4 Simulate or predict model output.

5 Design a controller for the estimated plant using other MathWorks
products.

You can import an estimated linear model into the Control System Toolbox,
Model Predictive Control Toolbox, Robust Control Toolbox, or Simulink
products for control design. For more information about linearizing a
nonlinear plant, see the linapp and linearize reference pages.
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Commands for Model Estimation

The following table summarizes System Identification Toolbox estimation
commands. For detailed information about using each command, see the
corresponding reference page.

Commands for Constructing and Estimating Models

Model Type Estimation Commands
Continuous-time low-order | pem
transfer functions (process
models)
Linear input-output armax (ARMAX only)
polynomial models arx (ARX only)
bj (BJ only)
iv4 (ARX only)
oe (OE only)
pem (for all models)
State-space models n4sid
pem
Linear time-series models ar
arx (for multiple outputs)
ivar
Nonlinear ARX models nlarx
Hammerstein-Wiener nlhw
models
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Tutorials to Help You Get Started

You can use the following tutorials to help you quickly get started with the

System Identification Toolbox software.

Tutorial

Description

Chapter 4, “Tutorial — Identifying
Linear Models Using the GUI”

You learn how to identify and
compare different linear black-box
models from data using the System
Identification Tool GUI.

Chapter 5, “Tutorial — Identifying
Low-Order Transfer Functions
(Process Models) Using the GUI”

You learn how to estimate

the parameters of low-order,
continuous-time transfer functions
from data using the System
Identification Tool GUI.

Chapter 6, “Tutorial — Identifying
Linear Models Using the Command
Line”

You learn how to identify different
linear models from data using
System Identification Toolbox
commands.

Chapter 7, “Tutorial — Identifying
Nonlinear Black-Box Models Using
the GUI”

You learn how to identify nonlinear
black-box models from data using
the System Identification Tool GUI.
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Tutorial — Identifying
Linear Models Using the
GUI

e “About This Tutorial” on page 4-2

e “Preparing Data for System Identification” on page 4-4

* “Saving the GUI Session” on page 4-20

¢ “Estimating Linear Models Using Quick Start” on page 4-23

¢ “Estimating Accurate Linear Models” on page 4-30

* “Viewing Model Parameters” on page 4-43

e “Exporting the Model to the MATLAB Workspace” on page 4-47
¢ “Exporting the Model to the LTI Viewer” on page 4-49
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About This Tutorial

In this section...

“Objectives” on page 4-2
“Data Description” on page 4-2

Obijectives

Estimate and validate linear models from single-input/single-output (SISO)
data to find the one that best describes the system dynamics.

After completing this tutorial, you will be able to accomplish the following
tasks using the System Identification Tool GUI:

® Import data arrays from the MATLAB workspace into the GUI.
Plot the data.

Process data by removing offsets from the input and output signals.

Estimate, validate, and compare linear models.

Export models to the MATLAB workspace.

Note The tutorial uses time-domain data to demonstrate how you
can estimate linear models. The same workflow applies to fitting
frequency-domain data.

This tutorial is based on the example in section 17.3 of System Identification:
Theory for the User, Second Edition, by Lennart Ljung, Prentice Hall PTR,
1999.

Data Description

This tutorial uses the data file dryer2.mat, which contains
single-input/single-output (SISO) time-domain data from Feedback Process
Trainer PT326. The input and output signals each contain 1000 data samples.



About This Tutorial

This system heats the air at the inlet using a mesh of resistor wire, similar to
a hair dryer. The input is the power supplied to the resistor wires, and the
output is the air temperature at the outlet.
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Preparing Data for System Identification

In this section...

“Loading Data into the MATLAB Workspace” on page 4-4
“Opening the System Identification Tool GUI” on page 4-4
“Importing Data Arrays into the System Identification Tool” on page 4-5

“Plotting and Processing Data” on page 4-10

Loading Data into the MATLAB Workspace

Load the data in dryer2.mat by typing the following command in the
MATLAB Command Window:

load dryer2

This command loads the data into the MATLAB workspace as two column
vectors, u2 and y2, respectively. The variable u2 is the input data and y2 is
the output data.

Opening the System Identification Tool GUI

To open the System Identification Tool GUI, type the following command
in the MATLAB Command Window:

ident
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The default session name, Untitled, appears in the title bar.

<} System Identification Tool - Untitled [ ]
File Options Window Help
Ilmport data - l Ilmpor‘t models - l
* Operations *
|<-- Preprocess - l
=
‘Wiorking Data
I Estimate --= - l
Data Wiews Model Yiews
To To
I~ Time: plat \Wiorkspace | |LTIViewwer | [T hode! outpot [~ Transient resp | L EE
[~ Data spectrs [~ Macdel resids [~ Freguency tesp [T Hamm-niener
[~ Frecuency. function [~ Zetos and poles
Ezxit I~ Moize spectrum
==t walidation Dats
Status line is here.

Importing Data Arrays into the System Identification
Tool

You can import the single-input/single-output (SISO) data from a sample data
file dryer2.mat into the GUI from the MATLAB workspace.

You must have already loaded the sample data into MATLAB, as described
in “Loading Data into the MATLAB Workspace” on page 5-5, and opened
the System Identification Tool GUI, as described in “Opening the System
Identification Tool GUI” on page 4-4.
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To import data arrays into the System Identification Tool GUI:

1 In the System Identification Tool GUI, select Import data > Time
domain data. This action opens the Import Data dialog box.

Impart data H

Impart data

Titne: dotmain data. ..

Freq. domain data...
Data ohject...
Example...

2 Specify the following options:

Input — Enter u2 as the name of the input variable.
Output — Enter y2 as the name of the output variable.

Data name — Change the default name to data. This name labels the
data in the System Identification Tool GUI after the import operation is
completed.

Starting time — Enter 0 as the starting time. This value designates
the starting value of the time axis on time plots.

Sampling interval — Enter 0.08 as the time between successive
samples in seconds. This value is the actual sampling interval in the
experiment.



Preparing Data for System Identification

The Import Data dialog box now resembles the following figure.

_inix)

Data Format for Signals

ITime-I]umain Signals j

Work=space Variable

Inpt: "'2
Outpt: hz

Data Information

Dats name: Eata
Starting time E
Sampling interval: E_DB

Imppart I Reset I

Cloze I Help I
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3 In the Data Information area, click More to expand the dialog box. Enter
the settings shown in the following figure.

J Import Data

Data Format for Signals

Time-Domain Signals j

Input Properties

Irter=ample: 0k

Period: inf

Workspace VWariable

Ingait; |J2
Outp: b,z

Channel Hame=s

Iripost: luower

Cutpu: temperature

Data Information

Data name: Eata
Starting time E
Sampling interwval: E_Da

Phys=ical Units of Variables

Ingt: IW
Hotes




Preparing Data for System Identification

Input Properties

InterSample — Accept the default zoh (zero-order hold) to indicate
that the input signal was piecewise-constant between samples during
data acquisition. This setting specifies the behavior of the input signals
between samples when you transform the resulting models between
discrete-time and continuous-time representations.

Period — Accept the default inf to specify a nonperiodic input.

Note For a periodic input, enter the whole number of periods of the
input signal in your experiment.

Channel Names

Input — Enter power.

Tip Naming channels helps you to identify data in plots. For
multivariable input and output signals, you can specify the names of
individual Input and Output channels, separated by commas.

Output — Enter temperature.

Physical Units of Variables

Input — Enter W for power units.

Tip When you have multiple inputs and outputs, enter a
comma-separated list of Input and Output units corresponding to each
channel.

Output — Enter ~oC for temperature units.

Notes — Enter comments about the experiment or the data. For
example, you might enter the experiment name, date, and a description
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of experimental conditions. When you estimate models from this data,
these models inherit your data notes.

4 Click Import to add the icon named data to the System Identification
Tool GUL

Ilmpu:urt data j
‘l Operations

AN — -
et |~=c FERFOCESS J
t
SRV
data
Warking Data

1

Estimate --= j

5 Click Close to close the Import Data dialog box.

Plotting and Processing Data
In this portion of the tutorial, you evaluate the data and process it for system
identification. You learn how to:

® Plot the data.
® Subtract the mean values of the input and the output to remove offsets.

e Split the data into two parts. You use one part of the data for model
estimation, and the other part of the data for model validation.

The reason you subtract the mean values from each signal is because,
typically, you build linear models that describe the responses for deviations
from a physical equilibrium. With steady-state data, it is reasonable to
assume that the mean levels of the signals correspond to such an equilibrium.
Thus, you can seek models around zero without modeling the absolute
equilibrium levels in physical units.



Preparing Data for System Identification

You must have already imported data into the System Identification Tool, as
described in “Importing Data Arrays into the System Identification Tool”
on page 4-5.

To plot and process the data:
1 In the System Identification Tool GUI, select the Time plot check box to

open the Time Plot. If the plot window is empty, click the data icon in
the System Identification Tool GUI.

=} Time Plot: power- =tempera : o ]
File Options Stwle Channel Help

Input and output signals

termperature

pawer

Time

The top axes show the output data (temperature), and the bottom axes
show the input data (power). Both the input and the output data have
nonzero mean values.

4-11



4 1iiorial - Identifying Linear Models Using the GUI

2 In the System Identification Tool GUI, select <--Preprocess > Remove

means to subtract the mean input value from the input data and the mean
output value from the output data.

.} System Identification Tool - Untitled

= _[o]x]
File Options Window Help
Ilmport data - l Ilmpor‘t models - l
* Operations *
,V\ =-- Preprocess - l
data

=-- Preprocess
Select channels..
Select experiments...
Merge experiments...
Select range

Remove trends k

Fitter...
Data Views Transform data... Macel Yiewes
Gick start . .
i Il autput Transient res Monlinear AREK

[~ Time plat N i r N
[ Data spectra [~ Macdel resids [~ Freguency tesp [T Hamm-niener
[ Frequency function W [~ Zetos and poles

. data i

Ezxit I~ Moize spectrum
= Yalilation Data

Click acknowledged. Mo action invoked.
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This action adds a new data set to the System Identification Tool GUI with
the default name datad (the suffix d means detrend), and updates the
Time Plot window to display both the original and the detrended data. The
detrended data has a zero mean value.

<} Time Plok: puwer—::=-ten1peratu‘i_'ﬁ_1_§ = |EI|5|
File Options Styvle Channel Help

Input and output signals

ternperature

power

Time
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3 In the System Identification Tool GUI, drag the datad data set to the
Working Data rectangle. This action specifies the detrended data to be
used for estimating models.

Ilmpnr‘t data j
‘l' Operstions
?W ?W I-:c__ F‘reprocess j
data datad

Wiarking Data

i

Estimate --» j

4 Select <--Preprocess > Select range to open the Select Range window.

In this window, you can split the data into two parts and specify the first
part for model estimation, and the second part for model validation, as
described in the following steps.



Preparing Data for System Identification

5 In the Select Range window, change the Samples field to select the first
500 samples, as follows:

1 500

) select Range: power-=temperature H |EI|5|

File Options Style Channel Help

Input and output signals

2
@ Time span:
‘E E 39.92
[1:] B
= 0O
% Samples:
o
oy 00
Dats name:
2
Fs’timate
g 1] Insert |
(]
o
Revert |
-2 Cloze |
1] 20 40 (a1} a0

Time

Prezs Insert to accept marked data set.

Tip You can also select data samples using the mouse by clicking and
dragging a rectangular region on the plot. If you select samples on the
input-channel axes, the corresponding region is also selected on the
output-channel axes.
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6 In the Data name field, type the name estimate, and click Insert. This
action adds a new data set to the System Identification Tool GUI to be
used for model estimation.

7 In the Select Range window, change the Samples field to select the last
500 samples, as follows:

501 1000

) Select Range: power->temperakure - Al |EI|5|

File Options Style Channel Help

Input and autput signals

Time =span:

FD 79.92

Samples:

-7 . . . EEH 1000

Dats name:

Falidaie|

In=ert |
Revert |
0 20 40 &0 @ . Coss |

Time

ternperature
=

power

Mevwy data zets may now be chasen.
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8 In the Data name field, type the name validate, and click Insert. This
action adds a new data set to the System Identification Tool GUI to be
used for model validation.

9 Drag and drop estimate to the Working Data rectangle, and drag and
drop validate to the Validation Data rectangle so that the System
Identification Tool GUI resembles the following figure.

) System Identification Tool - Untitled - 0] x|

File Options Window Help

Ilmport data - l Ilmpor‘t models - l
l Operations ;

,V\ ,V\ |<-- Preprocess - l
data datad 1‘
AN v
estimate validate iy
estimate
‘Wiorking Data
I Estimate --= - l
Data Wiews Model Yiews
To To
Workspace || LTI Viewer [ [T fodel output [~ Transient resp [~ Monfinesr AR
[~ Data spectra [~ Model resids [~ Freguency tesp [T Hamm-niener

|~ Frequency function w [~ | Zeros and poles
Exit walidate

[~ hoise spectrum
Ul Validation Data
Click on data/model icons to plotiunplot curves.
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10 To get information about a data set, right-click its icon. For example,
right-click the estimate data set to open the Data/model Info dialog box.

)} Data/model Info: estimate . - |EI|5|

Data name: Iestimate

Calat: l1 |D|D]

Time domain data set with 500 samples. ;I
Sampling interval; 0.05
Ot s Unit (if specified)
temperature o
(Inputs Unit (if specified)
pover Wy

Diary And Motes

W Import data
datad = dtrendidata,0)
estimate = datad([1:500])

Prezent Cloze Help |
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In the Data/model Info dialog box, you can perform the following actions:
® Change the name of the data set in the Data name field.

® Change the color of the data icon by changing the RGB values (relative
amounts of red, green, and blue). Each value is between 0 and 1. For
example, [1,0,0] indicates that only red is present, and no green and
blue are mixed into the overall color.

¢ In the noneditable area, view the total number of samples, the sampling
interval, and the output and input channel names and units.

¢ In the editable Diary And Notes area, view or edit the actions you
performed on this data set. The actions are translated into commands
equivalent to your GUI operations. For example, as shown in the
Data/model Info: estimate window, the estimate data set is a result of
importing the data, detrending the mean values, and selecting the first
500 samples of the data:

% Import data
datad = detrend(data,0)
estimate = datad([1:500])

For more information about these and other toolbox commands, see the
reference page corresponding to each command.

Tip As an alternative shortcut, you can select Preprocess > Quick start
from the System Identification Tool GUI to perform all of the data processing
steps in this tutorial.

Learn More

For information about supported data processing operations, such as
resampling and filtering the data, see the System Identification Toolbox
User’s Guide.
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Saving the GUI Session

After you process the data, as described in “Plotting and Processing Data”

on page 4-10, you can delete any data sets in the window that you do not
need for estimation and validation, and save your session. You can open this
session later and use it as a starting point for model estimation and validation
without repeating these preparatory steps.

You must have already processed the data into the System Identification Tool,
as described in “Plotting and Processing Data” on page 4-10.

To delete specific data sets from a session and save the session:

1 In the System Identification Tool GUI, drag and drop the data data set
into the Trash.

2 Drag and drop the datad data set into the Trash.

Note Moving items to the Trash does not delete them. To permanently
delete items, select Options > Empty trash in the System Identification
Tool GUI.

4-20



Saving the GUI Session

The following figure shows the System Identification Tool GUI after moving
the items to the Trash.

Impart data j
‘l Operations

Id-- Preprocess j

N L
% validate HJ\\/\M

estimate
‘Wiorking Drata

i

Estimate --= j

3 Drag and drop the estimate and validate data sets to fill the empty
rectangles, as shown in the following figure.

IImpu:urt data j
", Operations

: :W Id-- Preprocess d

eztimate validate 1‘

- W
estimate
Wiarking Data

i

Estimate —-= j

4 Select File > Save session as to open the Save Session dialog box, and
browse to the folder where you want to save the session file.

5 In the File name field, type the name of the session dryer2 prep_data,
and click Save. The resulting file has a .sid extension.
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Tip You can open a saved session when starting the System Identification
Tool. For example, you can type the following command in the MATLAB
Command Window:

ident('dryer2_prep_data')

For more information about managing sessions, see the topics on working
with the System Identification Tool GUI in the System Identification Toolbox
User’s Guide.
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Estimating Linear Models Using Quick Start

In this section...

“How to Estimate Linear Models Using Quick Start” on page 4-23
“Types of Quick Start Linear Models” on page 4-24
“Validating the Quick Start Models” on page 4-25

How to Estimate Linear Models Using Quick Start

You can use the Quick Start feature in the System Identification Toolbox to
estimate linear models. Quick Start might produce the final linear models
you decide to use, or provide you with information required to configure the
estimation of accurate parametric models, such as time constants, input
delays, and resonant frequencies.

You must have already processed the data for estimation, as described in
“Plotting and Processing Data” on page 4-10.

To identify linear models:

¢ In the System Identification Tool GUI, select Estimate > Quick start.

This action generates plots of step response, frequency-response, and the
output of state-space and polynomial models. For more information about
these plots, see “Validating the Quick Start Models” on page 4-25.
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)} System Identification Tool - dryer2_prep_data = |EI|1|
File Options Window Help
Ilmpurt data 'l Ilmpurt modelz 'l
“ Operations JL
\/\ |<_ Preprocess M l “; L \/
ostimate || validate 1 imp spad anas nds3a
A
= )
estimate
‘Working Data
Estimate —= -
Data Views Mocel Yiews
To To
[~ Time plot Workspace||LTI Viewer| | Modeloutput W Transientresp [ Hon
™ Data spectra ™ Model resids V¥ Frequency resp [~ Hamm-Vviener
r Fregquency function ™ Zeroz and poles
Exit | el validato ™ Noise =spectrum
ras Validation Data
Model n4s3 inserted. Double click on icon (right mouse) for text informstion.

Types of Quick Start Linear Models

Quick Start estimates the following four types of models and adds the
following to the System Identification Tool GUI with default names:

® imp — Step response over a period of time using the impulse algorithm.

® spad — Frequency response over a range of frequencies using the spa
algorithm. The frequency response is the Fourier transform of the impulse
response of a linear system.

By default, the model is evaluated at 128 frequency values, ranging from
0 to the Nyquist frequency.
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® arxgs — Fourth-order autoregressive (ARX) model using the arx algorithm.

This model is parametric and has the following structure:

¥y +ayt-D+...+a,,yt-n,) =
biult —ng)+...+ b pult —np —ny +1) +e(t)

y(t) represents the output at time ¢, u(t) represents the input at time ¢,

n, is the number of poles, n, is the number of b parameters (equal to the
number of zeros plus 1), n, is the number of samples before the input affects
output of the system (called the delay or dead time of the model), and e() is
the white-noise disturbance. The System Identification Toolbox product

estimates the parameters @y ...a, and b;...b, using the input and output
data from the estimation data set.

In arxgs, n,=n,=4, and n, is estimated from the step response model imp.

® n4s3 — State-space model calculated using n4sid. The algorithm
automatically selects the model order (in this case, 3).

This model is parametric and has the following structure:

x(t+1) = Ax(#) + Bu(t) + Ke(t)
(@) = Cx(t) + Du(t) + e(?)

y(t) represents the output at time ¢, u(¢) represents the input at time ¢, x
is the state vector, and e(t) is the white-noise disturbance. The System

Identification Toolbox product estimates the state-space matrices A, B,
C, D, and K.

Validating the Quick Start Models

Quick Start generates the following plots during model estimation to help you
validate the quality of the models:

® Step-response plot
¢ Frequency-response plot

e Model-output plot
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You must have already estimated models using Quick Start to generate
these plots, as described in “How to Estimate Linear Models Using Quick
Start” on page 4-23.

Step-Response Plot

The following step-response plot shows agreement among the different model
structures and the measured data, which means that all of these structures
have similar dynamics.

Tip If you closed the plot window, select the Transient resp check box to
reopen this window. If the plot is empty, click the model icons in the System
Identification Tool window to display the models on the plot.

<)} Transient Response: powWer-: p = |EI|5|

File Options Stwvle Channel Help

Step Response
1 T T T r

0.8 .
0.6 .
0.4 .
i
0.2 { .
0 _
0.2 . \ . .
-1 a 1 2 3 4

Time

Ma transient responze far SPA model.

Step Response for imp, arxqs, and n4s3



Estimating Linear Models Using Quick Start

Tip You can use the step-response plot to estimate the dead time of linear
systems. For example, the previous step-response plot shows a time delay of
about 0.25 s before the system responds to the input. This response delay,
or dead time, 1s approximately equal to about three samples because the
sampling interval is 0.08 s for this data set.

Frequency-Response Plot
The following frequency-response plot shows agreement among the different
model structures and the measured data, which means that all of these

structures have similar dynamics.

Tip If you closed this plot window, select the Frequency resp check box to
reopen this window. If the plot is empty, click the model icons in the System
Identification Tool window to display the models on the plot.

<} Frequency Function: power-> = |EI|5|
File Options Styvle  Channel Help
i Frequency response
10 r
o
=
= -1
= 3
por
=
% 2
10
I
=
%‘1 -200 4
&
m -400 ¢ 1
o
o
=8l B e e R
10 10 10 10
Freguency (radis)
Ma frequency response for IMPULSE REZPONSE madel.

Frequency Response for Models spad, arxqs, and n4s3
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Note The frequency-response plot does not include the impulse-response
model, imp.

Model-Output Plot
The Model Output window shows agreement among the different model
structures and the measured output in the validation data.

Tip If you closed the Model Output window, select the Model output check
box to reopen this window. If the plot is empty, click the model icons in the
System Identification Tool window to display the models on the plot.

<} Model Output: temperature [ [O] x|
File Options Style  Channel Help

Measured and simulated model output

1.4

1 n | BestFits

r f B Ind=3: 89.91

05l yl[ 1 Uﬁ“ arxs: 89.46
' 2 . )J ir imp: 89,05
0 _

-7 . . .
a0 a0 G0 7 20

Tirre

Mo model output far P& madels.

Measured Output and Model Output for Models imp, arxqs, and n4s3
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The model-output plot shows the model response to the input in the validation
data. The fit values for each model are summarized in the Best Fits area

of the Model Output window. The models in the Best Fits list are ordered
from best at the top to worst at the bottom. The fit between the two curves is
computed such that 100 means a perfect fit, and 0 indicates a poor fit (that
1s, the model output has the same fit to the measured output as the mean of
the measured output).

In this example, the output of the models matches the validation data output,
which indicates that the models seem to capture the main system dynamics
and that linear modeling is sufficient.

Tip To compare predicted model output instead of simulated output, select
this option from the Options menu in the Model Output window.
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Estimating Accurate Linear Models

In this section...

“Strategy for Estimating Accurate Models” on page 4-30
“Estimating Possible Model Orders” on page 4-30

“Identifying State-Space Models” on page 4-35

“Identifying ARMAX Input-Output Polynomial Models” on page 4-36
“Choosing the Best Model” on page 4-39

Strategy for Estimating Accurate Models

The linear models you estimated in “Estimating Linear Models Using Quick
Start” on page 4-23 showed that a linear model sufficiently represents the
dynamics of the system.

In this portion of the tutorial, you get accurate parametric models by
performing the following tasks:

1 Identifying initial model orders and delays from your data using a simple,
polynomial model structure (ARX).

2 Exploring more complex model structures with orders and delays close to
the initial values you found.

The resulting models are discrete-time models.

Tip You can convert a linear discrete-time model to a continuous-time
model using the d2c command. For more information, see the corresponding
reference page.

Estimating Possible Model Orders

To identify black-box models, you must specify the model order. However,
how can you tell what model orders to specify for your black-box models? To
answer this question, you can estimate simple polynomial (ARX) models for a
range of orders and delays and compare the performance of these models. You
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choose the orders and delays that correspond to the best model fit as an initial
guess for more accurate modeling.

About ARX Models
For a single-input/single-output system (SISO), the ARX model structure is:

y®+ayt-D+...+a,,yEt—n,) =
biu(t —ng)+...+bpu(t —ny —ny + D +e(?)

¥(t) represents the output at time ¢, u(?) represents the input at time ¢, n, is the
number of poles, n, is the number of zeros plus 1, n,, is the input delay—the
number of samples before the input affects the system output (called delay or
dead time of the model), and e(%) is the white-noise disturbance.

You specify the model orders n, n,, and n, to estimate ARX models. The
System Identification Toolbox product estimates the parameters @ ...a,
and b;...b, from the data.

How to Estimate Model Orders

1 In the System Identification Tool GUI, select Estimate > Linear
parametric models to open the Linear Parametric Models dialog box.

The ARX model is already selected in the Structure list.
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2 Edit the Orders field to try all combinations of poles, zeros, and delays,
where each value is from 1 to 10:

[1:10 1:10 1:10]

) Linear Parametric Models ;lglil
Structure: 2R (na b nk] -l
Orelers: [1:101:10 1:10]

Ecjuistion: Ay=Bu+e
hethoct: ¥ AR Lol
hame: I

Facus: IF'redic:tiDn ,I Intial state: I’ﬂ"‘"':' vI
Dist. model.  Estimate Covariance: IEs:timatE vI

[teration Fit: Improyement
[ Trace Stop fterations |
Order Selection I Order Editor. . |
Estimate | Close Help |
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3 Click Estimate to open the ARX Model Structure Selection window, which
displays the model performance for each combination of model parameters.

=)} ARX Model Structure Selection -0l x|

File Options Stwle  Help

Madel Misfitws number of par's
Green: MOL Choice

Elue: AIC Chaice I 5

1.5 Red Best Fit] | Misfit=0.20086

Murnber of par's

na=g
nb=9

nk=2

0.5 1 In=ert |

h_ﬂ Close |

1] Wﬂ]]]ﬂﬂ” Help |
10 20

a0

Unexplained output variance {in %)

Mumber of pat's

Click on bars to inzpect modelz.

You use this plot to select the best-fit model. The horizontal axis is the
total number of parameters:

Number of parameters =n, +n,

The vertical axis, called Unexplained output variance (in %), is

the portion of the output not explained by the model—the ARX model
prediction error for the number of parameters shown on the horizontal axis.
The prediction error is the sum of the squares of the differences between
the validation data output and the model one-step-ahead predicted output.
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Three rectangles are highlighted on the plot in green, blue, and red. Each
color indicates a type of best-fit criterion, as follows:

® Red — Best fit minimizes the sum of the squares of the difference
between the validation data output and the model output. This rectangle
indicates the overall best fit.

® Green — Best fit minimizes Rissanen MDL criterion.

e Blue — Best fit minimizes Akaike AIC criterion.

In this tutorial, the Unexplained output variance (in %) value remains
approximately constant for the combined number of parameters from 4 to
20. Such constancy indicates that model performance does not improve at
higher orders. Thus, low-order models might fit the data equally well.

Note When you use the same data set for estimation and validation, use
the MDL and AIC criteria to select model orders. These criteria compensate
for overfitting that results from using too many parameters. For more
information about these criteria, see the selstruc reference page.

In the ARX Model Structure Selection window, click the red bar
(corresponding to 15 on the horizontal axis), and click Insert. This
selection inserts n,=6, n,=9, and n,=2 into the Linear Parametric Models
dialog box and performs the estimation.

This action adds the model arx692 to the System Identification Tool GUI
and updates the plots to include the response of the model.

Note The default name of the parametric model contains the model type
and the number of poles, zeros, and delays. For example, arx692 is an ARX
model with n =6, n,=9, and a delay of two samples.

In the ARX Model Structure Selection window, click the third bar
corresponding to 4 parameters on the horizontal axis (the lowest order that
still gives a good fit), and click Insert.
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¢ This selection inserts n,=2, n,=2, and n,=3 (a delay of three samples) into
the Linear Parametric Models dialog box and performs the estimation.

® The model arx223 is added to the System Identification Tool GUI and
the plots are updated to include its response and output.

6 Click Close to close the ARX Model Structure Selection window.

Identifying State-Space Models

By estimating ARX models for different order combinations, as described in
“Estimating Possible Model Orders” on page 4-30, you identified the number
of poles, zeros, and delays that provide a good starting point for systematically
exploring different models.

The overall best fit for this system corresponds to a model with six poles, nine
zeros, and a delay of two samples. It also showed that a low-order model with
n,=2 (two poles), n,=2 (one zero), and n,=3 (input-output delay) also provides
a good fit. Thus, you should explore model orders close to these values.

In this portion of the tutorial, you estimate a state-space model.

About State-Space Models

The general state-space model structure (innovation form) is:

x(t+1) = Ax(¢) + Bu(t) + Ke(t)
y(@t) = Cx(t) + Du(t) + e(t)

y(t) represents the output at time ¢, u(t) represents the input at time ¢, x(t) is
the state vector at time ¢, and e(%) is the white-noise disturbance.

You must specify a single integer as the model order (dimension of the state
vector) to estimate a state-space model. By default, the delay equals 1. The
System Identification Toolbox product estimates the state-space matrices A,
B, C, D, and K from the data.

The state-space model structure is a good choice for quick estimation because

1t requires that you specify only two parameters to get started: n is the
number of poles (the size of the A matrix) and nk is the delay.
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How to Estimate State-Space Models

1 In the System Identification Tool GUI, select Estimate > Linear
parametric models to open the Linear Parametric Models dialog box.

2 From the Structure list, select State Space: n [nk].
3 In the Orders field, type 6 to create a sixth-order state-space model.

This choice is based on the fact that the best-fit ARX model has six poles.

Tip Although this tutorial estimates a sixth-order state-space model, you
might want to explore whether a lower-order model adequately represents
the system dynamics.

4 Click Estimate to add a state-space model called n4s6 to the System
Identification Tool GUI.

Tip If you closed the Model Output window, you can regenerate it by
selecting the Model output check box in the System Identification Tool
GUIL If the new model does not appear on the plot, click the model icon in
the System Identification Tool GUI to make the model active.

Learn More

To learn more about identifying state-space models, see the corresponding
topic in the System Identification Toolbox User’s Guide.

Identifying ARMAX Input-Output Polynomial Models

By estimating ARX models for different order combinations, as described in
“Estimating Possible Model Orders” on page 4-30, you identified the number
of poles, zeros, and delays that provide a good starting point for systematically
exploring different models.

The overall best fit for this system corresponds to a model with six poles, nine
zeros, and a delay of two samples. It also showed that a low-order model with
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n,=2 (two poles), n,=2 (one zero), and n,=3 also provides a good fit. Thus, you
should explore model orders close to these values.

In this portion of the tutorial, you estimate an ARMAX input-output
polynomial model.

About ARMAX Models

For a single-input/single-output system (SISO), the ARMAX polynomial
model structure is:

y@®+ayt-D+...+a,,yt-n,) =
biult —ng)+...+ b pult —np —np + 1)+
e®)+cret-D+...+c,e(t—n,)

¥(t) represents the output at time ¢, u(t) represents the input at time ¢, n is
the number of poles for the dynamic model, n, is the number of zeros plus 1, n,
is the number of poles for the disturbance model, n, is the number of samples
before the input affects output of the system (called the delay or dead time of
the model), and e(?) is the white-noise disturbance.

Note The ARMAX model is more flexible than the ARX model because
the ARMAX structure contains an extra polynomial to model the additive
disturbance.

You must specify the model orders to estimate ARMAX models. The System
Identification Toolbox product estimates the model parameters @; ..., ,

by...b,, and ¢j...c, from the data.

How to Estimate ARMAX Models

1 In the System Identification Tool GUI, select Estimate > Linear
parametric models to open the Linear Parametric Models dialog box.

2 From the Structure list, select ARMAX: [na nb nc nk] to estimate an
ARMAX model.
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3 In the Orders field, set the orders na, nb, nc, and nk to the following values:

2222

The model name in the Name field is amx2222, by default.

4 Click Estimate to add the ARMAX model to the System Identification
Tool GUL

5 Repeat steps 3 and 4 using higher Orders 3 3 2 2. These orders result in
a model that fits the data almost as well as the higher order ARX model
arxe692.
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Learn More

To learn more about identifying input-output polynomial models, such as
ARMAX, see the corresponding topic in the System Identification Toolbox
User’s Guide.
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Choosing the Best Model

You can compare models to choose the model with the best performance.

You must have already estimated the models, as described in “Estimating

Accurate Linear Models” on page 4-30.

Summary of Models

The following figure shows the System Identification Tool GUI, which
includes all of the estimated models in “Estimating Accurate Linear Models”

on page 4-30.
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Examining the Model Output

If you closed the Model Output plot, you can regenerate it by selecting the
Model output check box in the System Identification Tool GUI. If the model
does not appear on the plot, click the model icon in the System Identification

Tool GUI to display it on plots.

Examine the model-output plot to see how well the model output matches the
measured output in the validation data set. A good model is the simplest
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model that best describes the dynamics and successfully simulates or predicts
the output for different inputs.

Models are listed by name in the Best Fits area of the Model Output plot.
The highest-order model you created, arx692, fits the data as well as the
simpler model amx3322.

<} Model Dutput: temperature =] B3
File Options Style Channel Help
Measzured and simulated model output
1.8
i Best Fits
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40 an G0 Fill] a0
Time
Mo model output for SPA models.

Tip To validate your models using a different data set, you can drag and drop
this data set into the Validation Data rectangle in the System Identification
Tool GUI. If you transform validation data into the frequency domain, the
model-output plot updates to show the model comparison in the frequency
domain.
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To get a closer look at how well these models fit the data, magnify a portion of
the plot by clicking and dragging a rectangle around the region of interest, as
shown in the following figure.

<} Model Dutput: temperature =] B3
File Options Style Channel Help
Measzured and simulated model output
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Mo model output for SPA models.
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Releasing the mouse magnifies this region and shows that the output of all

models matches the validation data well.
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Viewing Model Parameters

In this section...

“Viewing Model Parameter Values” on page 4-43

“Viewing Parameter Uncertainties” on page 4-46

Viewing Model Parameter Values

You can view the numerical parameter values for each estimated model.

You must have already estimated the models, as described in “Estimating
Accurate Linear Models” on page 4-30.

To view the parameter values of the model amx3322, right-click the model icon
in the System Identification Tool GUIL The Data/model Info dialog box opens.
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<} Data/model Info: amx3322

hodel name: Iamx3322
Calat:

§10507]

Discrete-time IDPOLY model Alg)yit) = El(q}lu(tj + C(q)e(t}l_l
Alg)=1-1508g~1 +07291 g~2-012 "3

Big) = 0.004257 g2 + 0.06201 g"-3+0 02643 g4

Clg) =1 -0.5833 ™1 + 0.2538 g"-2

Estimated using PEM using SearchiMethod = Auto from dat;
Loss function 0.00155233 and FPE 0.00160302

Sampling interval: 0.05 i
K | _'*IJ

Diary And Motes

% Import  data
datad = detrend(data,d)
estimate = datad([1:300])

amx3322 = armaxlestimate [3 3 2 21) LI

Present I Cloze I Help |

The noneditable area of the Data/model Info dialog box lists the following
parameter values:

A(q) =1 - 1.508g9"-1 + 0.7291g"-2 - 0.12199"-3
B(g) = 0.004257¢q"-2 + 0.06201q"-3 + 0.02643q"-4
C(q) =1 - 0.58359"-1 + 0.2588q"-2
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These parameter values correspond to the following difference equation for
your system:

y(@#)—1.508y(& —-1)+0.7291y(t — 2) - 0.1219y(t - 3) =
0.004257u(t —2)+0.06201u(t —3) + 0.02643u(t —4) +
e(t)—0.5835e(t —1) + 0.2588e(t — 2)

Note The coefficient of u(#-2) is not significantly different from zero. This
lack of difference explains why delay values of both 2 and 3 give good results.

Parameter values appear in the following format:

AlQ=1+a1q +...+ay,q ™
B(q) — blq_nk +. .+ ban—nb—nk+1

Cl@Q=1+c1q  +...+cpoq ™

The parameters appear in the ARMAX model structure, as follows:

A(Q)y(@) = B(Qu(t) + C(q)e(t)

which corresponds to this general difference equation:

y®+a1yt-D+...+a,,yEt—n,) =
bju(t—ng)+...+bpu(t —ny —ny + D+
e +cret—-D+...+c,.et—n.)

y(t) represents the output at time ¢, u(?) represents the input at time ¢, n, is
the number of poles for the dynamic model, n, is the number of zeros plus 1, n,
is the number of poles for the disturbance model, n,, is the number of samples
before the input affects output of the system (called the delay or dead time of
the model), and e(%) is the white-noise disturbance.
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Viewing Parameter Uncertainties

You can view parameter uncertainties of estimated models.

You must have already estimated the models, as described in “Estimating
Accurate Linear Models” on page 4-30.

To view parameter uncertainties, click Present in the Data/model Info dialog
box, and view the model information in the MATLAB Command Window.

A(q) =

4+ =

- + + O

- 1.508(+-0.05919)q" -1
0.7291(+-0.08734)q"-2
0.1219 (+-0.03424)q"-3

.004257(+-0.001563)q" -2

0.06201(+-0.002409)q"-3
0.02643(+-0.005633)q"-4
0.5835(+-0.07189)q" -1
0.2588(+-0.05253)q"-2

+

The 1-standard-deviation uncertainty for the model parameters is in
parentheses next to each parameter value.
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Exporting the Model to the MATLAB Workspace

The models you create in the System Identification Tool GUI are not
automatically available in the MATLAB workspace. To make a model
available to other toolboxes, the Simulink software, and the System
Identification Toolbox commands, you must export your model from the
System Identification Tool to the MATLAB workspace. For example, if the
model is a plant that requires a controller, you can import the model from the
MATLAB workspace into the Control System Toolbox product.

You must have already estimated the models, as described in “Estimating
Accurate Linear Models” on page 4-30.

To export the amx3322 model, drag it to the To Workspace rectangle in
the System Identification Tool GUI. The model appears in the MATLAB
Workspace browser.

« ) Workspace -0l x|
File Edit ‘Wew Graphics Debug Deskbop Window »
': By = | b ‘ = Stack:IBase YI
Mame £ |'l.-'a|ue |Class

5] arnx3322 <1x1%8 idpoly= idpaly

Kl | H

Note This model is an object that belongs to the idpoly model class. To
learn more about this model object, see the corresponding reference page.
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After the model is in the MATLAB workspace, you can perform other
operations on the model. For example, if you have the Control System Toolbox
product installed, you might transform the model to a state-space LTI object
using:

ss_model=ss(amx3322)

You can extract the dynamic model and ignore the noise model using the
following command:

ss_model=ss_model('m')
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Exporting the Model to the LTI Viewer

If you have the Control System Toolbox product installed on your computer,
the To LTI Viewer rectangle appears in the System Identification Tool GUI.

The LTI Viewer is a graphical user interface for viewing and manipulating
the response plots of linear models. It displays the following plots:

® Step- and impulse-response

¢ Bode, Nyquist, and Nichols

¢ Frequency-response singular values

® Pole/zero

® Response to general input signals

¢ Unforced response starting from given initial states (only for state-space

models)

To plot a model in the LTI Viewer, drag and drop the model icon to the To
LTI Viewer rectangle in the System Identification Tool GUI.

For more information about working with plots in the LTI Viewer, see the
Control System Toolbox documentation.
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Tutorial — Identifying
Low-Order Transfer
Functions (Process Models)

Using the GUI

e “About This Tutorial” on page 5-2
® “What Is a Continuous-Time Process Model?” on page 5-4
e “Preparing Data for System Identification” on page 5-5

¢ “Estimating a Second-Order Transfer Function (Process Model) with
Complex Poles” on page 5-13

e “Estimating a Transfer Function with a Noise Model” on page 5-22
* “Viewing Model Parameters” on page 5-30
¢ “Exporting the Model to the MATLAB Workspace” on page 5-33

® “Simulating a System Identification Toolbox Model in Simulink Software”
on page 5-34
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About This Tutorial

In this section...

“Objectives” on page 5-2

“Data Description” on page 5-3

Obijectives

Estimate and validate simple, continuous-time transfer functions from
single-input/single-output (SISO) data to find the one that best describes
the system dynamics.

After completing this tutorial, you will be able to accomplish the following
tasks using the System Identification Tool GUI:

® Import data objects from the MATLAB workspace into the GUI.

® Plot and process the data.

e Estimate and validate low-order, continuous-time models from the data.

¢ Export models to the MATLAB workspace.

Simulate the model using Simulink software.

Note This tutorial uses time-domain data to demonstrate how you
can estimate linear models. The same workflow applies to fitting
frequency-domain data.




About This Tutorial

Data Description

This tutorial uses the data file proc_data.mat, which contains 200 samples
of simulated single-input/single-output (SISO) time-domain data. The input
is a random binary signal that oscillates between -1 and 1. White noise
(corresponding to a load disturbance) is added to the input with a standard
deviation of 0.2, which results in a signal-to-noise ratio of about 20 dB. This
data is simulated using a second-order system with underdamped modes
(complex poles) and a peak response at 1 rad/s:

G(s) = %e%
1+02s+s

The sampling interval of the simulation is 1 second.
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What Is a Continuous-Time Process Model?

Continuous-time process models are low-order transfer functions that describe
the system dynamics using static gain, a time delay before the system output
responds to the input, and characteristic time constants associated with poles
and zeros. Such models are popular in the industry and are often used for
tuning PID controllers, for example. Process model parameters have physical
significance.

You can specify different process model structures by varying the number of
poles, adding an integrator, or including a time delay or a zero. The highest
process model order you can specify in this toolbox is three, and the poles can
be real or complex (underdamped modes).

In general, a linear system is characterized by a transfer function G, which is
an operator that takes the input u to the output y:

y=Gu

For a continuous-time system, G relates the Laplace transforms of the input
U(s) and the output Y(s), as follows:

Y(s) = G(s)U(s)

In this tutorial, you estimate G using different process-model structures.

For example, the following model structure is a first-order, continuous-time
model, where K is the static gain, Tp ; 1s a time constant, and T, is the
input-to-output delay:

K —sT,

Gs)=——e
1+ STpl



Preparing Data for System Identification

Preparing Data for System Identification

In this section...
“Loading Data into the MATLAB Workspace” on page 5-5

“Opening the System Identification Tool GUI” on page 5-5
“Importing Data Objects into the System Identification Tool” on page 5-6

“Plotting and Processing Data” on page 5-9

Loading Data into the MATLAB Workspace

Load the data in proc_data.mat by typing the following command in the
MATLAB Command Window:

load proc_data

This command loads the data into the MATLAB workspace as the data
object z. For more information about iddata objects, see the corresponding
reference page.

Opening the System Identification Tool GUI

To open the System Identification Tool GUI, type the following command
MATLAB Command Window:

ident
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The default session name, Untitled, appears in the title bar.

<} System Identification Tool - Untitled [ ]
File Options Window Help
Ilmport data - l Ilmpor‘t models - l
* Operations *
|<-- Preprocess - l
=
‘Wiorking Data
I Estimate --= - l
Data Wiews Model Yiews
To To
I~ Time: plat \Wiorkspace | |LTIViewwer | [T hode! outpot [~ Transient resp | L EE
[~ Data spectrs [~ Macdel resids [~ Freguency tesp [T Hamm-niener
[~ Frecuency. function [~ Zetos and poles
Ezxit I~ Moize spectrum
==t walidation Dats
Status line is here.

Importing Data Objects into the System Identification

Tool
You can import data object into the GUI from the MATLAB workspace.

You must have already loaded the sample data into MATLAB, as described in
“Loading Data into the MATLAB Workspace” on page 5-5, and opened the
GUI, as described in “Opening the System Identification Tool GUI” on page
5-5.

To import a data object into the System Identification Tool GUI:



Preparing Data for System Identification

1 In the System Identification Tool GUI, select Import data > Data object.

This action opens the Import Data dialog box.

Import data j

Impart data
Titne dotmain data..
Freq. domain data. ..

Example...

2 Specify the following options:

® Object — Enter z as the name of the MATLAB variable that is the
time-domain data object. Press Enter.

¢ Data name — Use the default name z, which is the same as the name
of the data object you are importing. This name labels the data in the
System Identification Tool GUI after the import operation is completed.

e Starting time — Enter 0 as the starting time. This value designates
the starting value of the time axis on time plots.

¢ Sampling interval — Enter 1 as the time between successive samples
in seconds. This value represents the actual sampling interval in the
experiment.

The Import Data dialog box now resembles the following figure.
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=l0lx

Data Format for Signals

IDDATA or IDFRDVFRD

Work=space Variable

Ohject: IZ

Ohject clazs: IDDATA, (Time Damain]

Data name:
Starting tirne:
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Data Information
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Preparing Data for System Identification

3 Click Import to add the icon named z to the System Identification Tool
GUL

rnpart data H
Jv Operations

“w |~:-- Preprocess j
z

1)
Al

z
Wiorking Data

i

| Estimate = -]

=

4 Click Close to close the Import Data dialog box.

Plotting and Processing Data

In this portion of the tutorial, you evaluate the data and process it for system
identification. You learn how to:

¢ Plot the data.
® Subtract the mean values of the input and the output to remove offsets.

e Split the data into two parts. You use one part of the data for model
estimation, and the other part of the data for model validation.

The reason you subtract the mean values from each signal is because,
typically, you build linear models that describe the responses for deviations
from a physical equilibrium. With steady-state data, it is reasonable to
assume that the mean levels of the signals correspond to such an equilibrium.
Thus, you can seek models around zero without modeling the absolute
equilibrium levels in physical units.

You must have already imported data into the System Identification Tool, as

described in “Importing Data Objects into the System Identification Tool”
on page 5-6.
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To plot and process the data:

1 In the System Identification Tool GUI, select the Time plot check box to
open the Time Plot window.

<) Time Plok: ul-=y¥1 o ]
File Options Stwle Channel Help
Input and output signals
] r : .
st ]
-5 L L i
1
= Op
-1
1] al 100 1580 200
Time

The bottom axes show the input data—a random binary sequence, and
the top axes show the output data.

The next two steps demonstrate how to modify the axis limits in the plot.

2 To modify the vertical-axis limits for the input data, select Options > Set
axes limits.
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3 In the Limits for Time Plot dialog box, set the new vertical axis limit of the
input data channel ul to [-1.5 1.5]. Click Apply and Close.

JRIeTE
Time [V Auto
[0 z00) [ Log
%1 [V Auto
[-55] [ Loy
L v Auto
[-151.3 [ Log
Apply | Cloze

Note The other two fields in the Limits for Time Plot dialog box, Time
and y1, let you set the axis limits for the time axis and the output channel
axis, respectively. You can also specify each axis to be logarithmic or linear
by selecting the corresponding option.
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The following figure shows the updated time plot.

<) Time Plok: ul-=y¥1 o ]
File Options Stwle Channel Help
Input and output signals
] r : .
st ]
-5 L L i
1t
= 1
-1
1] al 100 180 200
Time

4 In the System Identification Tool GUI, select <—-Preprocess > Quick
start to perform the following four actions:

e Subtract the mean value from each channel.

® Split the data into two parts.

¢ Specify the first part of the data as estimation data (or Working Data).
® Specify the second part of the data as Validation Data.

Learn More

For information about supported data processing operations, such as
resampling and filtering the data, see the System Identification Toolbox
User’s Guide.

5-12



Estimating a Second-Order Transfer Function (Process Model) with Complex Poles

Estimating a Second-Order Transfer Function (Process
Model) with Complex Poles

In this section...

“Estimating a Second-Order Transfer Function Using Default Settings”
on page 5-13

“Tips for Specifying Known Parameters” on page 5-18

“Validating the Model” on page 5-18

Estimating a Second-Order Transfer Function Using
Default Settings

In this portion of the tutorial, you estimate models with this structure:

K e—Tds

)= (1+28T,5+T,%5%)

You must have already processed the data for estimation, as described in
“Plotting and Processing Data” on page 5-9.

To identify a second-order transfer function:
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1 In the System Identification Tool GUI, select Estimate > Process models
to open the Process Models dialog box.

=10l

Model Transfer Function Pararneter Knowwh Walue Initisl Guess Bounds
K - | | auto | [infinf]
K exp(-Td =) LI | | auo | 0.001 Inf]
01+ Tpl =) P2 [ o | © | 19001 Inf)
L [ o | © | 19001 Inf)
Poles Iz = [ o | © | Lt inf]
[ =] fJerrea -l e | | auo | (030
Initial Guess
[~ Zero
v Auto-selected
[ Delay
~ From existing model: I
[ Integratar -
{~ User-defined Yalue--=lnitial Guess

Dizturbance Madel: INl:unE = I Initial state: suto e
Focus: ISimuIation = I Covariance: IEstimate = I Options... |

fteration Fit: Improverment [~ Trace Stop terations |

Mane: D Estitnate | Cloze | Help |
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2 In the Model Transfer Function area, specify the following options:
e Under Poles, select 2 and Underdamped.

This selection updates the Model Transfer Function to a second-order
model structure that can contain complex poles.

hodel Transfer Function

K expl-Td =)

[1 + (2 Zeta Tw) = + (Twwe 212

Underdatmped u

Al real
[T Zero

¥ Delay
[T Integrator

The Parameter area now shows four active parameters: K, Tw, Zeta,
and Td. By default, the model Name (located at the bottom of the dialog
box) 1s set to the acronym P2DU, which indicates two poles (P2), a delay
(D), and underdamped modes (U).

e Make sure that the Zero and Integrator check boxes are cleared to
exclude a zero and an integrator (self-regulating ) from the model.
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3 In the Initial Guess area, keep the default Auto-selected option to
calculate the initial parameter values during the estimation. The Initial
Guess column in the Parameter table displays Auto.

Farameter Knowr Walue Initial Guess Boundz
o | | auto | [nf In]
(N | | | auto | [0.001 Inf]
ista = | | auto | [0.001 Inf]
s | o | o | [0.001 Inf]

= | o | o | Finting
=B | | auto | 1030
Initial Guess

{* Auto-selected

" Fram existing model: I

" U=ser-defined Salue--=Initial Guess

4 Keep the default Bounds values, which specify the minimum and
maximum values of each parameter.

Tip If you know the range of possible values for a parameter, you can type
these values into the corresponding Bounds fields to help the estimation
algorithm.

5 Keep the default settings for the estimation algorithm:

* Disturbance Model — None means that the algorithm does not
estimate the noise model. This option also sets the Focus to Simulation.

® Focus — Simulation means that the estimation algorithm does not use
the noise model to weigh the relative importance of how closely to fit
the data in various frequency ranges. Instead, the algorithm uses the
input spectrum in a particular frequency range to weigh the relative
importance of the fit in that frequency range.
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Tip The Simulation setting is optimized for identifying models that
you plan to use for output simulation. If you plan to use your model

for output prediction or control applications, or to improve parameter
estimates using a noise model, select Prediction.

¢ Initial state — Auto means that the algorithm analyzes the data and
chooses the optimum method for handling the initial state of the system.
If you get poor results, you might try setting a specific method for
handling initial states, rather than choosing it automatically.

* Covariance — Estimate means that the algorithm computes parameter
uncertainties that display as model confidence regions on plots.

6 Click Estimate. This selection adds the model P2DU to the System
Identification Tool GUI.
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Tips for Specifying Known Parameters

If you know a parameter value exactly, you can type this value in the Initial
Guess column of the Process Models dialog box.

If you know the approximate value of a parameter, you can help the estimation
algorithm by entering an initial value in the Initial Guess column. In this
case, keep the Known check box cleared to allow the estimation to fine-tune
this initial guess.

For example, to fix the time-delay value Td at 2s, you can type this value into
Value field of the Parameter table in the Process Models dialog box and select
the corresponding Known check box.

Farameter Known Walue Initial Guess Bounds
| ] | st | [ntinf]
A ] | auto | [0.001 Inf]
Ista [~ ] | st | [0.001 Inf]
U | @ | o | [0.001 Inf]
I I e | it inf]
Td v | = [ R
Initial Guess

" Auto-selected

™ From existing model:

% zer-defined Yalue--=lnitisl Guess

Validating the Model

You can analyze the following plots to evaluate the quality of the model:

¢ Comparison of the model output and the measured output on a time plot

e Autocorrelation of the output residuals, and cross-correlation of the input
and the output residuals
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You must have already estimated the model, as described in “Estimating a
Second-Order Transfer Function Using Default Settings” on page 5-13.

Examining Model Output

You can use the model-output plot to check how well the model output
matches the measured output in the validation data set. A good model is the
simplest model that best describes the dynamics and successfully simulates or
predicts the output for different inputs.

To generate the model-output plot:

¢ Select the Model output check box in the System Identification Tool GUI.

If the plot is empty, click the model icon in the System Identification Tool
window to display the model on the plot.

<} Model Dutput: y1 H=] B
File Options Style Channel Help
Measured and simulated model output
4 T . . -
BestFits
P20 734
2t |
0 1
2l J
-4 1 1 L L
100 120 140 160 180 200
Time

The System Identification Toolbox product uses input validation data as input
to the model, and plots the simulated output on top of the output validation
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data. The preceding plot shows that the model output agrees well with the
validation-data output.

The Best Fits area of the Model Output plot shows the agreement (in percent)
between the model output and the validation-data output.

Recall that the data was simulated using the following second-order system
with underdamped modes (complex poles), as described in “Data Description”
on page 5-3, and has a peak response at 1 rad/s:

Glo) = ——— e
1+0.2s+s

Because the data includes noise at the input during the simulation, the
estimated model cannot exactly reproduce the model used to simulate the
data.

Examining Model Residuals
You can validate a model by checking the behavior of its residuals.

To generate a Residual Analysis plot, select the Model resids check box in
the System Identification Tool GUI.
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<} Residual Analysis: ul-=yl
File Options Style Channel Help

Autocorrelation of residuals far output ¥

Samples

The top axes show the autocorrelation of residuals for the output (whiteness
test). The horizontal scale is the number of lags, which is the time difference
(in samples) between the signals at which the correlation is estimated. Any
fluctuations within the confidence interval are considered to be insignificant.
A good model should have a residual autocorrelation function within the
confidence interval, indicating that the residuals are uncorrelated. However,
in this example, the residuals appear to be correlated, which is natural
because the noise model is used to make the residuals white.

The bottom axes show the cross-correlation of the residuals with the

input. A good model should have residuals uncorrelated with past inputs
(independence test). Evidence of correlation indicates that the model does not
describe how a portion of the output relates to the corresponding input. For
example, when there is a peak outside the confidence interval for lag k&, this
means that the contribution to the output y(¢) that originates from the input
u(t-k) is not properly described by the model. In this example, there is no
correlation between the residuals and the inputs.

Thus, residual analysis indicates that this model is good, but that there might
be a need for a noise model.
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Estimating a Transfer Function with a Noise Model

In this section...

“Estimating a Second-Order Transfer Function with Complex Poles and
Noise” on page 5-22

“Validating the Models” on page 5-24

Estimating a Second-Order Transfer Function with
Complex Poles and Noise

In this portion of the tutorial, you estimate a second-order transfer function
and include a noise model. By including a noise model, you optimize the
estimation results for prediction application.

You must have already estimated the model, as described in “Estimating a
Second-Order Transfer Function Using Default Settings” on page 5-13.

To estimate a second-order transfer function with noise:
1 If the Process Models dialog box is not open, select Estimate > Process

models in the System Identification Tool GUI. This action opens the
Process Models dialog box.




Estimating a Transfer Function with a Noise Model

2 In the Model Transfer Function area, specify the following options:
e Under Poles, select 2 and Underdamped.

This selection updates the Model Transfer Function to a second-order
model structure that can contain complex poles.

hodel Transfer Function

K expl-Td =)

[1 + (2 Zeta Tw) = + (Twwe 212

Underdatmped u

Al real
[T Zero

¥ Delay
[T Integrator

e Make sure that the Zero and Integrator check boxes are cleared to
exclude a zero and an integrator (self-regulating ) from the model.

* Disturbance Model — Set to Order 1 to estimate a noise model H as a
continuous-time, first-order ARMA model:

H=£e
D

where and D are first-order polynomials, and e is white noise.

This action specifies the Focus as Prediction, which improves accuracy
in the frequency range where the noise level is low. For example, if there
1s more noise at high frequencies, the algorithm assigns less importance
to accurately fitting the high-frequency portions of the data.

e Name — Edit the model name to P2DUe1 to generate a model with a
unique name in the System Identification Tool GUI.
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3 Click Estimate.

4 In the Process Models dialog box, set the Disturbance Model to Order 2
to estimate a second-order noise model.

5 Edit the Name field to P2DUe2 to generate a model with a unique name in
the System Identification Tool GUI.

6 Click Estimate.

Validating the Models

In this portion of the tutorial, you evaluate model performance using the
Model Output and the Residual Analysis plots.

You must have already estimated the models, as described in “Estimating a
Second-Order Transfer Function Using Default Settings” on page 5-13 and
“Estimating a Second-Order Transfer Function with Complex Poles and
Noise” on page 5-22.

Comparing the Model Output Plots

To generate the Model Output plot:

¢ Select the Model output check box in the System Identification Tool GUI.
If the plot is empty or a model output does not appear on the plot, click the

model icons in the System Identification Tool window to display these models
on the plot.



Estimating a Transfer Function with a Noise Model

The following Model Output plot shows the simulated model output, by
default. The simulated response of the models is approximately the same for
models with and without noise. Thus, including the noise model does not
affect the simulated output.

<} Model Dutput: y1 [_|O0]
File Options Style Channel Help

Measzured and simulated model output

4
BestFits
P20l 734
2t 4 [FP2DLet: 7831
F20lles: 78.23
il u
gt i

100 120 140 160 180 200
Time

To view the predicted model output:

¢ In the Model Output plot window, select Options > 5 step ahead
predicted output.
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The following Model Output plot shows that the predicted model output of
P2DUe2 (with a second-order noise model) is better than the predicted output
of the other two models (without noise and with a first-order noise model,
respectively).

<} Model Dutput: y1 E=]
File Options Style Channel Help

Measured and & step predicted output

4
BestFits
F20llez: 81.41
2t 1 [F2DL: 784
F20let: 77.82
il a
gt i

100 120 140 160 180 200
Time
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Comparing the Residual Analysis Plots
To generate the Residual Analysis plot:

e Select the Model resids check box in the System Identification Tool GUI.

If the plot is empty, click the model icons in the System Identification Tool
window to display these models on the plot.

P2DUe2 falls well within the confidence bounds on the Residual Analysis plot.

<} Residual Analysis: ul->y1

File Options Style  Channel Help

Altocorrelation of residuals for output 4

Cross corr for input ul and outputyl resids

Samples
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To view residuals for P2DUe2 only, remove models P2DU and P2DUe1 from the
Residual Analysis plot by clicking the corresponding icons in the System
Identification Tool GUI.

Ilmpnr‘t modelz _v_l

4

FZ0OU |[PZDUe] [P0
i
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The Residual Analysis plot updates, as shown in the following figure.

<} Residual Analysis: ul-=yl
File Options Style Channel Help

Autocorrelation of residuals far output ¥
0.4 . . :

Samples

The whiteness test for P2DUe2 shows that the residuals are uncorrelated, and
the independence test shows no correlation between the residuals and the
inputs. These tests indicate that P2DUe2 is a good model.
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Viewing Model Parameters

In this section...

“Viewing Model Parameter Values” on page 5-30

“Viewing Parameter Uncertainties” on page 5-31

Viewing Model Parameter Values

You can view the numerical parameter values and other information about

the model P2DUe2 by right-clicking the model icon in the System Identification
Tool GUI. The Data/model Info dialog box opens.

<} Data/model Info: P2ZDUe2
Model name: F2DLIE2
Colar: i1 DD]
Process madel with transfer function i
Kp
Gis) = * expl-Td*s)
1+2* Zeta* Twhs+(Twhs)™2
with Kp=0.93735
Tw =0.99874
Zeta=0.10529 T
Tal — 7 ANCOD
« | L|_|
Diary And Motes
=l
% Import z
zd = dtrend{z,0)
zde = zd{[1:100])
P2DUe2 = pemizde 'P2DU"Dist' ' ARMAZ'); 2
Present I Close I Help |

The noneditable area of the dialog box lists the model coefficients that
correspond to the following model structure:
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G(s) = K 53 e "dt
(1+2§Tws+Tw s )

For the model P2DUe2:

Kp is 0.99783.

Tw is 0.99874.

Zeta is 0.10829.

Td is 2.0058.

These coefficients agree with the model used to simulate the data:

Gls) = — e
1+0.2s+s

P2DUe2 also includes an additive noise term, where H is a second-order ARMA
model and e is white noise:

H=—c¢
D

The Data/model Info dialog box gives the noise model H as a ratio of two
polynomials, C(s)/D(s), where:

(@}
—_
)
-

1l

$"2 + 2.14(+-0.08596)s + 1.175(+-0.3083)
= $°2 + 0.2427(+-0.08213)s + 0.61(+-0.07577)

[w)
w
|

The 1-standard-deviation uncertainty for the model parameters is in
parentheses next to each parameter value.

Viewing Parameter Uncertainties

To view parameter uncertainties for the system transfer function, click
Present in the Data/model Info dialog box, and view the information in the
MATLAB Command Window.

Kp = 0.99738+-0.01951
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Tw = 0.99874+-0.0037075
Zeta = 0.10829+-0.0040998
Td = 2.0058+-0.002329

The 1-standard-deviation uncertainty for each model parameter follows the
+- symbol.
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Exporting the Model to the MATLAB Workspace

You can perform further analysis on your estimated models from the
MATLAB workspace. For example, if the model is a plant that requires a
controller, you can import the model from the MATLAB workspace into the
Control System Toolbox product. Furthermore, to simulate your model in the
Simulink software (perhaps as part of a larger dynamic system), you can
import this model as a Simulink block.

The models you create in the System Identification Tool GUI are not
automatically available in the MATLAB workspace. To make a model
available to other toolboxes, Simulink, and the System Identification Toolbox

commands, you must export your model from the System Identification Tool
to the MATLAB workspace.

To export the P2DUe2 model:
¢ In the System Identification Tool GUI, drag the model icon to the To

Workspace rectangle. The model now appears in the MATLAB Workspace
browser.

Note This model is an object of idproc class. Model objects encapsulate
all properties of the model. To learn more about this model object, see the
corresponding reference page.

5-33



5 Tutorial - Identifying Low-Order Transfer Functions (Process Models) Using the GUI

Simulating a System Identification Toolbox Model in
Simulink Software

In this section...

“Prerequisites for This Tutorial” on page 5-34
“Preparing Input Data” on page 5-34
“Building the Simulink Model” on page 5-35

“Configuring Blocks and Simulation Parameters” on page 5-36

“Running the Simulation” on page 5-40

Prerequisites for This Tutorial

In this tutorial, you create a simple Simulink model that uses blocks from
the System Identification Toolbox library to bring the data z and the model
P2DUe2 into Simulink.

To perform the steps in this tutorial, Simulink must be installed on your
computer.

Furthermore, you must have already performed the following steps:

® Load the data set, as described in “Loading Data into the MATLAB
Workspace” on page 5-5.

¢ Estimate the second-order process model, as described in “Estimating a
Second-Order Transfer Function with Complex Poles and Noise” on page
5-22.

¢ Export the model to the MATLAB workspace, as described in “Exporting
the Model to the MATLAB Workspace” on page 5-33.

Preparing Input Data

Use the input channel of the data set z as input for simulating the model
output by typing the following in the MATLAB Command Window:

reates a new iddata object.

z_input = z %
= ets the output channel

C
z_input.y [1 % S

5-34



Simulating a System Identification Toolbox™ Model in Simulink® Software

% to empty.

Alternatively, you can specify any input signal.

Learn More

For more information about representing data signals for system
identification, see the System Identification Toolbox User’s Guide.

Building the Simulink Model
To add blocks to a Simulink model:

1 In the MATLAB Command Window, type simulink.
2 Select File > New > Model to open a new model window.
3 In the Simulink Library Browser, select the System Identification

Toolbox library. The right side of the window displays blocks specific to
the System Identification Toolbox product.

Tip Another way to access the System Identification block library is to
type slident in the MATLAB Command Window.

4 Drag the following System Identification Toolbox blocks to the new model
window:

e IDDATA Sink block
e IDDATA Source block
e IDMODEL model block

5 In the Simulink Library Browser, select the Simulink > Sinks library,
and drag the Scope block to the new model window.
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6 In the Simulink model window, connect the blocks until your model
resembles the following figure.

File Edit Wiew Simulation Format

Tools  Help

=10l x|

D& :BR[E= 4202 r =i

I Marmal

[

iddatar1, 1)

Ready

Iddata Saurce

P Input
IDDATA SINK
Output
Idd ata Sink
Input ids=-1,1,1,00 - L]
Scope
Output b ldmodel
[1o09 | |ode4s

A

In the next section, you configure these blocks to get data from the MATLAB
workspace and set the simulation time interval and duration.

Learn More

For more information about working with Simulink models, see the Simulink

documentation.

Configuring Blocks and Simulation Parameters
This procedure guides you through the following tasks to configure the model

blocks:

® Getting data from the MATLAB workspace.

e Setting the simulation time interval and duration.

1 In the new model window, select Simulation > Configuration

Parameters.
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2 In the Configuration Parameters dialog box, type 200 in the Stop time
field. Click OK.

This value sets the duration of the simulation to 200 seconds.

3 Double-click the Iddata Source block to open the Source Block Parameters:
Iddata Source dialog box. Then, type the following variable name in the
Iddata object field:

z_input

This variable is the data object in the MATLAB workspace that contains
the input data.

1 source Block Parameters: Iddata Source ) x|

—lddata [nputdutput [mazk] [link]

Thiz block allowes o impart IDOATA object from the main work, space of bMatlab.

The firgt outpuk port of the block coresponds to the input zsignal of the (DDAT A
nbject and the second output port comesponds ta the output signal.

Enter an IDDATA object in the dialog field.

—Parameters

|ddata object

Z_input

] Cancel Help

Tip As a shortcut, you can drag and drop the variable name from the
MATLAB Workspace browser to the Iddata object field.

4 Click OK.
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5 Double-click the Idmodel block to open the Function Block Parameters:
Idmodel dialog box. Type the following variable name in the idmodel
variable field:

P2DUe2

This variable represents the name of the model in the MATLAB workspace.

[=1Function Block Parameters: Idmodel x|

—|dmodel Black [maszk] [link]

Enter any |dmadel object [|dpaly, 1dzz, [dars, |darey ar [dprac].
For zimulatiohz with noize, Seed(z] may be left empty for random
restarks.

Enter az many zeeds az there are outputs for specific realizations.

—Parameterz

idmode| wariable
|P2DUe2

|nitial ztate [ztate space anly: ‘2", 'm', or vechor |
|0
[~ Add noize

MHoize zeed(z). Defaulk empty

k. Cancel
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6 Clear the Add noise check box to exclude noise from the simulation. Click
OK.

When Add noise is selected, Simulink derives the noise amplitude from
the NoiseVariance property of the model and adds noise to the model
accordingly. The simulation propagates this noise according to the noise
model H that was estimated with the system dynamics:

H=—e¢
D

7 Double-click the Iddata Sink block to open the Sink Block Parameters:
Iddata Sink dialog box. Type the following variable name in the IDDATA
Name field:

z_sim_out

8 Type 1 in the Sample Time (sec.) field to set the sampling time of the
output data to match the sampling time of the input data. Click OK.

E! Sink Block Parameters: Iddata Sink x|

—IDDATA Sink [maszk] (link)

Enter in a name of a vanable for which you would ke the IDDATA
data object be zaved. The zample time iz the rate that the data will
be zampled.

—Parameters

[DDATA Mame

Iz_sim_u:uut

Sample Time [zec.]

[1

k. Cancel Help Apply
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The resulting change to the Simulink model is shown in the following figure.

L=

File Edit Wiew Simulation Format Tools Help

DeH&| BR[| 42 & p =1 Poo |[voma  [5]|

P Input
IDDATA SINK
Output
Idd ata Sink
z_input Input e P2hUez foe |:|
ldmedel Soope
lddata Saurce
Ready [1o09 | |ode4s 4

Running the Simulation

1 In the Simulink model window, select Simulation > Start.

2 Double-click the Scope block to display the time plot of the model output.
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-)scope =10l x|
SE|PLL ABE DA T -

l
|| I'lJ \'IHW""|""|'+|‘”

Titme offset: 0O

3 In the MATLAB Workspace browser, notice the variable z_sim_out that
stores the model output as an iddata object. You specified this variable
name when you configured the Iddata Sink block.

This variable stores the simulated output of the model, and it is now
available for further processing and exploration.
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Tutorial — Identifying
Linear Models Using the
Command Line

e “About This Tutorial” on page 6-2

e “Preparing Data” on page 6-4

¢ “Estimating Step- and Frequency-Response Models” on page 6-15

e “Estimating Delays in the Multiple-Input System” on page 6-20

¢ “Estimating Model Orders Using an ARX Model Structure” on page 6-23

¢ “Estimating Continuous-Time Transfer Functions (Process Models)” on
page 6-31

¢ “Estimating Black-Box Polynomial Models” on page 6-42
¢ “Simulating and Predicting Model Output” on page 6-54
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About This Tutorial

In this section...

“Objectives” on page 6-2

“Data Description” on page 6-2

Obijectives

Estimate and validate linear models from multiple-input/single-output
(MISO) data to find the one that best describes the system dynamics.

After completing this tutorial, you will be able to accomplish the following
tasks using the command line:

¢ (Create data objects to represent data.

Plot the data.

Process data by removing offsets from the input and output signals.

Estimate and validate linear models from the data.

Simulate and predict model output.

Note This tutorial uses time-domain data to demonstrate how you
can estimate linear models. The same workflow applies to fitting
frequency-domain data.

Data Description

This tutorial uses the data file co2data.mat, which contains two experiments
of two-input and single-output (MISO) time-domain data from a steady-state
that the operator perturbed from equilibrium values.

In the first experiment, the operator introduced a pulse wave to both inputs.
In the second experiment, the operator introduced a pulse wave to the first
input and a step signal to the second input.



About This Tutorial

Input 1:

Rate of Chemical ——Jm{

Consumption
(kg/min)

Input 2:

Current (A) ————Tp

CO2
Production
Process

Cutput:

——3p Rate of CO2Z

Production
(mgfmin)
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Preparing Data

In this section...

“Loading Data into the MATLAB Workspace” on page 6-4

“Plotting the Input/Output Data” on page 6-5

“Removing Equilibrium Values from the Data” on page 6-6

“Using Objects to Represent Data for System Identification” on page 6-7
“Creating iddata Objects” on page 6-8

“Plotting the Data in a Data Object” on page 6-9

“Selecting a Subset of the Data” on page 6-13

Loading Data into the MATLAB Workspace

Load the data in co2data.mat by typing the following in the MATLAB
Command Window:

load co2data;

This command loads the following five variables into the MATLAB Workspace:

e Input_expl and Output_exp1 are the input and output data from the first
experiment, respectively.

e Input_exp2 and Output_exp2 are the input and output data from the
second experiment, respectively.

e Time is the time vector from 0 to 1000 minutes, increasing in equal
increments of 0.5 min.

For both experiments, the input data consists of two columns of values. The
first column of values is the rate of chemical consumption (in kilograms per
minute), and the second column of values is the current (in amperes). The
output data is a single column of the rate of carbon-dioxide production (in
milligrams per minute).




Preparing Data

Plotting the Input/Output Data

You can plot the input and output data from both experiments using the
following commands:

% Plot the input and output data from both experiments
plot(Time,Input_exp1,Time,Output_exp1)

legend('Input 1','Input 2','Output 1')

figure

plot(Time,Input_exp2,Time,Output_exp2)

legend('Input 1','Input 2','Output 1')

The resulting plot shows the first experiment, where the operator applies a
pulse wave to each input to perturb it from its steady-state equilibrium.

JFigue1 =0l x|
File Edit “iew Insert Tools Desktop  MWindow  Help k"
NeWHa| k|eams € 0B =0
200
Input 1 |
150 + Input 2 |4
Clutput 1
100 + 5
5|:| s R R s T TR L N— L S— L N— N T—
ol gl
=y ﬁmwmm
-100 1 1 1 1
1] 200 400 GO0 800 1000

Input and Output Data from Experiment 1
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The next plot shows the second experiment, where the operator applies a
pulse wave to the first input and a step signal to the second input.

=
File Edit ‘Wiew Insert Tools Desktop  Window  Help k"
NS E&|(h RQaO®|E|0E =0
200 T T T T
Input 1 ||
Input 2
i — Output 1
100 - .
all =
ot y
_ED 1 1 1 1
0 200 400 GO0 a0 1000

Input and Ovutput Data from Experiment 2

Removing Equilibrium Values from the Data

Plotting the data, as described in “Plotting the Input/Output Data” on page
6-5, shows that the inputs and the outputs have nonzero equilibrium values.
In this portion of the tutorial, you subtract equilibrium values from the data.

The reason you subtract the mean values from each signal is because,
typically, you build linear models that describe the responses for deviations
from a physical equilibrium. With steady-state data, it is reasonable to
assume that the mean levels of the signals correspond to such an equilibrium.
Thus, you can seek models around zero without modeling the absolute
equilibrium levels in physical units.



Preparing Data

Zoom in on the plots to see that the earliest moment when the operator
applies a disturbance to the inputs occurs after 25 minutes of steady-state
conditions (or after the first 50 samples). Thus, the average value of the first
50 samples represents the equilibrium conditions.

Use the following commands to remove the equilibrium values from the inputs
and the outputs in both experiments:

% Remove the equilibrium values from inputs
% and outputs in both experiments:
Input_exp1 = Input_expl-...
ones(size(Input_exp1,1),1)*mean(Input_exp1(1:50,:));
Output_expl = Output_expi-...
mean (Output_exp1(1:50,:));
Input_exp2 = Input_exp2-...
ones(size(Input_exp2,1),1)*mean(Input_exp2(1:50,:));
Output_exp2 = Output_exp2-...
mean (Output_exp2(1:50,:));

Note The ones command replicates the two mean values, one for each input,
in a two-dimensional array.

Using Objects to Represent Data for System
Identification

The System Identification Toolbox data objects, iddata and idfrd,
encapsulate both data values and data properties into a single entity. You can
use the System Identification Toolbox commands to conveniently manipulate
these data objects as single entities.

In this portion of the tutorial, you create two iddata objects, one for each
of the two experiments. You use the data from Experiment 1 for model
estimation, and the data from Experiment 2 for model validation. You work
with two independent data sets because you use one data set for model
estimation and the other for model validation.
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Note When two independent data sets are not available, you can split one
data set into two parts, assuming that each part contains enough information
to adequately represent the system dynamics.

Creating iddata Objects

You must have already loaded the sample data into the MATLAB workspace,
as described in “Loading Data into the MATLAB Workspace” on page 7-9.

Use these commands to create two data objects, ze and zv:

% Create two data objects, ze and zv.

Ts = 0.5; % Sampling interval is 0.5 min
ze = iddata(Output_expi1,Input_expl1,Ts);
iddata(Output_exp2,Input_exp2,Ts);

N
<
1}

ze contains data from Experiment 1 and zv contains data from Experiment 2.
Ts is the sampling interval.

The iddata constructor requires three arguments for time-domain data and
has the following syntax:

data_obj = iddata(output,input,sampling_interval);

To view the properties of an iddata object, use the get command. For
example, type this command to get the properties of the estimation data:

get(ze)

To learn more about the properties of this data object, see the iddata
reference page.



Preparing Data

To modify data properties, you can use dot notation or the set command. For
example, to assign channel names and units that label plot axes, type the
following syntax in the MATLAB Command Window:

% Set time units to minutes
ze.TimeUnit = 'min';

% Set names of input channels

ze.InputName = {'ConsumptionRate', 'Current'};
% Set units for input variables

ze.InputUnit = {'kg/min','A'};

% Set name of output channel

ze.OutputName = 'Production’;

% Set unit of output channel

ze.OutputUnit = 'mg/min';

% Set validation data properties

zv.TimeUnit = 'min';

zv.InputName = {'ConsumptionRate’', 'Current'};
zv.InputUnit {'kg/min', 'A'};

zv.OutputName = 'Production’;

zv.OutputUnit = 'mg/min';

You can verify that the InputName property of ze is changed, or “index into”
this property, by typing the following syntax:

ze.inputname

Tip Property names, such as InputUnit, are not case sensitive. You can also
abbreviate property names that start with Input or Output by substituting u
for Input and y for Output in the property name. For example, OutputUnit is
equivalent to yunit.

Plotting the Data in a Data Object
You can plot iddata objects using the MATLAB plot command:

plot(ze) % Plot the estimation data
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This opens the following plot. The bottom axes show the first input
ConsumptionRate, and the top axes show the output ProductionRate.

) Figuret - o x|

File Edit ‘Wiew Insert Tools Desktop  Mindow  Help N
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ConsumptionRate

kafrmin
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Input 1 and Output for ze

For multivariable data, only one input/output pair appears on the plot at a
time. To view the second input Current, select the MATLAB Figure window,

and press Enter to update the plot.
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Tip For plots of data with multiple inputs and outputs, press Enter to view
the next input/output pair.
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To plot the validation data in a new MATLAB Figure window, type the
following commands in the MATLAB Command Window:

figure % Open a new MATLAB Figure window
plot(zv) % Plot the validation data

EETTEE— _ioix)

File Edit Miew Insert Tools Deskbop  Window Help L
D ES|yaams (@08 0O

ProductionRate
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Input 1 and Output for zv
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Select the MATLAB Figure window, and press Enter to view the second

input on the plot.
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Input 2 and Output for zv

Zoom in on the plots to see that the experiment process amplifies the first
input (ConsumptionRate) by a factor of 2, and amplifies the second input

(Current) by a factor of 10.

Selecting a Subset of the Data

Before you begin, create a new data set that contains only the first 1000
samples of the original estimation and validation data sets to speed up the

calculations:
Zel = ze(1:1000);
Zvi = zv(1:1000);
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For more information about indexing into iddata objects, see the
corresponding reference page.
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Estimating Step- and Frequency-Response Models

In this section...

“Why Estimate Step- and Frequency-Response Models?” on page 6-15
“Estimating the Frequency Response” on page 6-15

“Estimating the Step Response” on page 6-18

Why Estimate Step- and Frequency-Response
Models?

Frequency-response and step-response are nonparametric models that can
help you understand the dynamic characteristics of your system. These

models are not represented by a compact mathematical formula with
adjustable parameters. Instead, they consist of data tables.

In this portion of the tutorial, you estimate these models using the data set
ze. You must have already created ze, as described in “Creating iddata
Objects” on page 6-8.

The response plots from these models show the following characteristics of
the system:

¢ The response from the first input to the output might be a second-order
function.

¢ The response from the second input to the output might be a first-order
or an overdamped function.

Estimating the Frequency Response
The System Identification Toolbox product provides three functions for

estimating the frequency response:
e etfe computes the empirical transfer function using Fourier analysis.

® spa estimates the transfer function using spectral analysis for a fixed
frequency resolution.

e spafdr lets you specify a variable frequency resolution for estimating the
frequency response.
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Use the spa command to estimate the frequency response:
Ge=spa(ze);

To plot the frequency response as a Bode plot, type the following command
in the MATLAB Command Window:

bode (Ge)

This command produces the following plot.
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Frequency Response for the First Input-Output Path
The amplitude peaks at the frequency of about 0.7 rad/s, which suggests

a possible resonant behavior (complex poles) for the first input-to-output
combination—ConsumptionRate to ProductionRate.
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To view the second input Current, select the MATLAB Figure window, and
press Enter. The input/output pair is displayed, as shown in the following

figure.
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Frequency Response for the Second Input-Output Path

In both plots, the phase rolls off rapidly, which suggests a time delay for both

input/output combinations.

Tip When your data contains multiple inputs and outputs, press Enter to

view the next input/output pair.
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Estimating the Step Response

To estimate the step response from the data, use the step command with the
following arguments:

step(ze,30)

The first step argument is the name of the data object. The second argument
is the duration of the step input in the time units you specified (minutes).

This calculation produces the following plot.
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Step Response from Both Inputs to the Output
The step response for the first input/output combination suggests an

overshoot, which indicates the presence of an underdamped mode (complex
poles) in the physical system.
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The step response from the second input to the output shows no overshoot,
which indicates either a first-order response or a higher-order response with
real poles (overdamped response).

The step-response plot indicates a nonzero delay in the system, which is

consistent with the rapid phase roll-off you got in the Bode plot you created
in “Estimating the Step Response” on page 6-18.
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Estimating Delays in the Multiple-Input System

In this section...

“Why Estimate Delays?” on page 6-20
“Estimating Delays Using the ARX Model Structure” on page 6-20

“Estimating Delays Using Alternative Methods” on page 6-21

Why Estimate Delays?

To i1dentify parametric black-box models, you must specify the input/output
delay as part of the model order.

If you do not know the input/output delays for your system from the
experiment, you can use the System Identification Toolbox software to
estimate the delay.

Estimating Delays Using the ARX Model Structure

In the case of single-input systems, you can read the delay on the
impulse-response plot. However, in the case of multiple-input systems, such
as the one in this tutorial, you might be unable to tell which input caused the
initial change in the output and you can use the delayest command instead.

The delayest command estimates the time delay in a dynamic system by

estimating a low-order, discrete-time ARX model with a range of delays, and
then choosing the delay that corresponding to the best fit.
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The ARX model structure is one of the simplest black-box parametric
structures. In discrete-time, the ARX structure is a difference equation with
the following form:

¥y +ayt-D+...+a,,yt-n,) =
biult —ng)+...+ b pult —np —ny +1) +e(t)

¥(t) represents the output at time ¢, u(?) represents the input at time ¢, n, is
the number of poles, n, is the number of b parameters (equal to the number
of zeros plus 1), n,, is the number of samples before the input affects output
of the system (called the delay or dead time of the model), and e(z) is the
white-noise disturbance.

delayest assumes that n,=n,=2 and that the noise e is white or insignificant,
and estimates n,,.

To estimate the delay in this system, type the following command in the
MATLAB Command Window:

delayest(ze)

System Identification Toolbox software responds with the following:

ans =
5 10

This result includes two numbers because there are two inputs: the estimated
delay for the first input is 5 data samples, and the estimated delay for the
second input is 10 data samples. Because the sampling interval for the
experiments is 0.5 min, this corresponds to a 2.5-min delay before the first
input affects the output, and a 5.0-min delay before the second input affects
the output.

Estimating Delays Using Alternative Methods

There are two alternative methods for estimating the time delay in the system:

¢ Plot the time plot of the input and output data and read the time difference
between the first change in the input and the first change in the output.
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6-22

This method is practical only for single-input/single-output system; in the
case of multiple-input systems, you might be unable to tell which input
caused the initial change in the output.

Plot the impulse response of the data with a 1-standard-deviation
confidence region. You can estimate the time delay using the time when
the impulse response is first outside the confidence region.
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Estimating Model Orders Using an ARX Model Structure

In this section...
“Why Estimate Model Order?” on page 6-23

“Commands for Estimating the Model Order” on page 6-23
“Model Order for the First Input-Output Combination” on page 6-25

“Model Order for the Second Input-Output Combination” on page 6-28

Why Estimate Model Order?

Model order is one or more integers that define the complexity of the model.
In general, model order is related to the number of poles, the number of zeros,
and the response delay (time in terms of the number of samples before the
output responds to the input). The specific meaning of model order depends
on the model structure.

To compute parametric black-box models, you must provide the model order
as an input. If you do not know the order of your system, you can estimate it.

After completing the steps in this section, you get the following results:

® For the first input/output combination: n =2, n,=2, and the delay n,=5.

® For the second input/output combination: n =1, n,=1, and the delay n,=10.

Later, you explore different model structures by specifying model-order values
that are slight variations around these initial estimate.

Commands for Estimating the Model Order

In this portion of the tutorial, you use struc, arxstruc, and selstruc to
estimate and compare simple polynomial (ARX) models for a range of model
orders and delays, and select the best orders based on the quality of the model.

The following list describes the results of using each command:

® struc creates a matrix of model-order combinations for a specified range of
n, n,, and n, values.
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e arxstruc takes the output from struc, systematically estimates an
ARX model for each model order, and compares the model output to the
measured output. arxstruc returns the loss function for each model, which

1s the normalized sum of squared prediction errors.

® selstruc takes the output from arxstruc and opens the ARX Model
Structure Selection window, which resembles the following figure, to help

you choose the model order.
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You use the preceding plot to select the best-fit model. The horizontal axis
1s the total number of parameters:

Number of parameters =n, +n,

For the ARX model, n, is the number of poles, n, is the number of b
parameters (equal to the number of zeros plus 1), and n, is the delay.

The vertical axis, called Unexplained output variance (in %), is

the portion of the output not explained by the model—the ARX model
prediction error for the number of parameters shown on the horizontal axis.
The prediction error is the sum of the squares of the differences between
the validation data output and the model one-step-ahead predicted output.

Three rectangles are highlighted on the plot in green, blue, and red. Each
color indicates a type of best-fit criterion, as follows:

= Red — Best fit minimizes the sum of the squares of the difference
between the validation data output and the model output. This rectangle
indicates the overall best fit.

= Green — Best fit minimizes Rissanen MDL criterion.
= Blue — Best fit minimizes Akaike AIC criterion.

In this tutorial, the Unexplained output variance (in %) value remains
approximately constant for the combined number of parameters from 4 to
20. Such constancy indicates that model performance does not improve at
higher orders. Thus, low-order models might fit the data equally well.

Note When you use the same data set for estimation and validation, use
the MDL and AIC criteria to select model orders. These criteria compensate
for overfitting that results from using too many parameters. For more
information about these criteria, see the selstruc reference page.

Model Order for the First Input-Output Combination

In this tutorial, there are two inputs to the system and one output and you
estimate model orders for each input/output combination independently. You
can either estimate the delays from the two inputs simultaneously or one
input at a time.
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It makes sense to try the following order combinations for the first
input/output combination:

® n,=2:5
® n,=1:5

° nk:5

This i1s because the nonparametric models you estimated in “Estimating Step-
and Frequency-Response Models” on page 6-15 show that the response for the
first input/output combination might have a second-order response. Similarly,
in “Estimating Delays in the Multiple-Input System” on page 6-20, the delay
for this input/output combination was estimated to be 5.

To estimate model order for the first input/output combination:
1 Use struc to create a matrix of possible model orders.

NN1 = struc(2:5,1:5,5);

2 Use selstruc to compute the loss functions for the ARX models with the
orders in NN1.

selstruc(arxstruc(ze(:,:,1),zv(:,:,1),NN1))

Note (ze(:,:,1) selects the first input in the data.




Estimating Model Orders Using an ARX Model Structure

This command opens the interactive ARX Model Structure Selection
window.

=} ARX Model Structure Selection o Im] 1

File Options Stvle Help
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Inzpect models by clicking bars or press SELECT.

Note The Rissanen MDL and Akaike AIC criteria produces equivalent
results and are both indicated by a blue rectangle on the plot.

The red rectangle represents the best overall fit, which occurs for n =2,
n,=3, and n,=5. The height difference between the red and blue rectangles
is insignificant. Therefore, you can choose the parameter combination that
corresponds to the lowest model order and the simplest model.
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3 Click the blue rectangle, and then click Select to choose that combination
of orders:

4 To continue, press any key while in the MATLAB Command Window.

Model Order for the Second Input-Output
Combination

It makes sense to try the following order combinations for the second
input/output combination:

®* n~=1:3

® n,=1:3

* n,=10

This is because the nonparametric models you estimated in “Estimating Step-
and Frequency-Response Models” on page 6-15 show that the response for the
second input/output combination might have a first-order response. Similarly,

in “Estimating Delays in the Multiple-Input System” on page 6-20, the delay
for this input/output combination was estimated to be 10.

To estimate model order for the second input/output combination:

1 Use struc to create a matrix of possible model orders.

NN2 = struc(1:3,1:3,10);



Estimating Model Orders Using an ARX Model Structure

2 Use selstruc to compute the loss functions for the ARX models with the

orders in NN2.

selstruc(arxstruc(ze(:,:,2),zv(:,:,2),NN2))

This command opens the interactive ARX Model Structure Selection

window.
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Note The Akaike AIC and the overall best fit criteria produces equivalent
results. Both are indicated by the same red rectangle on the plot.

The height difference between all of the rectangles is insignificant and
all of these model orders result in similar model performance. Therefore,
you can choose the parameter combination that corresponds to the lowest
model order and the simplest model.

Click the yellow rectangle on the far left, and then click Select to choose

the lowest order: n =1, n,=1, and n,=10.
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4 To continue, press any key while in the MATLAB Command Window.
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Estimating Continuous-Time Transfer Functions (Process

Models)

In this section...

“Specifying the Structure of the Process Model” on page 6-31
“Viewing the Model Structure and Parameter Values” on page 6-32
“Specifying Initial Guesses for Time Delays” on page 6-34
“Estimating Model Parameters Using pem” on page 6-34
“Validating the Process Model” on page 6-36

“Estimating a Transfer Function with a Noise Model” on page 6-39

Specifying the Structure of the Process Model

In this portion of the tutorial, you estimate a low-order, continuous-time
transfer function (process model). the System Identification Toolbox product
supports continuous-time models with at most three poles (which might
contain underdamped poles), one zero, a delay element, and an integrator.

You must have already prepared your data, as described in “Preparing Data”
on page 6-4.

You can use the following results of estimated model orders to specify the
orders of the model:
¢ For the first input/output combination, use:

= Two poles, corresponding to n,=2 in the ARX model.

= Delay of 5, corresponding to n,=5 samples (or 2.5 minutes) in the ARX
model.

® For the second input/output combination, use:
= One pole, corresponding to n,=1 in the ARX model.

= Delay of 10, corresponding to n,=10 samples (or 5 minutes) in the ARX
model.
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Note Because there is no relationship between the number of zeros estimated
by the discrete-time ARX model and its continuous-time counterpart, you

do not have an estimate for the number of zeros. In this tutorial, you can
specify one zero for the first input/output combination, and no zero for the
second-output combination.

Use the idproc command to create two model structures, one for each
input/output combination:

midprocO = idproc({'P2zZUD', 'P1D'});

The argument of idproc is a cell array that contains two strings, where each
string specifies the model structure for each input/output combination:

e 'P27UD' represents a transfer function with two poles (P2), one zero (2),
underdamped (complex-conjugate) poles (U) and a delay (D).

® 'P1D' represents a transfer function with one pole (P1) and a delay (D).

Viewing the Model Structure and Parameter Values

To view the two resulting models, type the following command in the
MATLAB Command Window:

midprocO



Estimating Continuous-Time Transfer Functions (Process Models)

MATLAB displays the following model structure:
Process model with 2 inputs: y = G_1(s)u_1 + G_2(s)u_2
where
1+Tz*s

G_1(S) = Kp * ----mmmmmmmmmee o * exp(-Td*s)
1+2*Zeta*Tw*s+ (Tw*s) "2

with Kp = NaN

Tw = NaN
Zeta = NaN
Td = NaN
Tz = NaN
Kp
G_2(s) = ---------- * exp(-Td*s)
1+Tp1*s

with Kp = NaN
Tp1 = NaN
Td = NaN
This model was not estimated from data.

The parameter values are set to NaN because they are not yet estimated.
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Specifying Initial Guesses for Time Delays

Set the time delay property of the model object to 2.5 min and 5 min for each
input/output pair as initial guesses. Also, set an upper limit on the delay
because good initial guesses are available.

midproc0.Td.value = [2.5 5];
midproc0.Td.max = [3 7];

Note When setting the Td model property, you must specify the delays in
terms of actual time units (minutes, in this case) and not the number of
samples.

Estimating Model Parameters Using pem

pem is an iterative estimation command, which means that it uses an iterative
nonlinear least-squares algorithm to minimize a cost function. The cost
function is the weighted sum of the squares of the errors.

Depending on its arguments, pem estimates different black-box polynomial
models. You can use pem, for example, to estimate parameters for linear
continuous-time transfer-function, state-space, or polynomial model
structures. To use pem, you must provide a model structure with unknown
parameters and the estimation data as input arguments.

For this portion of the tutorial, you must have already defined the model
structure, as described in “Specifying the Structure of the Process Model” on
page 6-31. Use midprocO as the model structure and Ze1 as the estimation
data:

midproc = pem(Zei,midprocO);
present(midproc)
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MATLAB displays the following model structure with estimated parameter
values:

Process model with 2 inputs: y = G_1(s)u_1 + G_2(s)u_2
where

G_1(S) = Kp * ----mmmmmmmmmeeee e * exp(-Td*s)
1+2*Zeta*Tw*s+(Tw*s) ~2

with Kp = 0.11276+-7.3308
Tw 108.08+-196.4
Zeta = 1.8735+-3.5244

Td = 0+-1.5255
Tz = 9031.6+-5.5446e+005
Kp
G_2(8) = ---------- * exp(-Td*s)
1+Tp1*s
with Kp = 10.068+-0.062327
Tp1 = 2.1189+-0.072149
Td = 4.8392+-0.046529

Estimated using PEM using SearchMethod = Auto from
data set Zet
Loss function 8.89822 and FPE 9.04059

Unlike discrete-time polynomial models, continuous-time models let you
estimate the delays. In this case, the estimated delay values 0 and 4.8392
are different from the initial guesses you specified of 2.5 and 5, respectively.
The large uncertainties in the estimated values of the parameters of G_1(s)
indicate that the dynamics from input 1 to the output are not captured well.

To learn more about estimating models, see the corresponding topic in the
System Identification Toolbox documentation.
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Validating the Process Model

In this portion of the tutorial, you create a plot that compares the actual
output and the model output using the compare command:

compare(Zvi,midproc)
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The preceding plot shows that the model output reasonably agrees with the
measured output: there is an agreement of 65.6% between the model and the
validation data.

Use resid to perform residual analysis:

resid(Zv1,midproc)
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Because the sample system has two inputs, there are two cross-correlation
plots of the residuals with each input, as shown in the following figure.

-loix
File Edit Yiew Insert Tools Desktop ‘Window Help ]
DeEE K |&RaM® (¢ 08| 8O
Correlation function of residuals. Qutput ProductionRate
1 T T T T
o
0sr | o 4
To
D I e Ve B A ET e (7 M T (4] ¢'
s 1 1 1 1
0 5 10 15 20 25
lag
Crass carr. function between input ConsumptionRate and residuals fram output ProductionRate
I:|2 T T T T T T T T T
i et et
1 - .
_D2 1 | | | 1 | | 1 |
-25 -20 -5 -0 5 ] & 10 15 20 25
lag

Autocorrelation and Cross-Correlations of Residuals with the First Input
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The cross-correlation between the first input and residual errors is significant.

After MATLAB displays the first plot, press Enter to view the
cross-correlation with the second input, as shown in the following figure.
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Cross-Correlations of Residuals with the Second Input

In the preceding figure, the autocorrelation plot shows values outside the
confidence region and indicates that the residuals are correlated. However,
the cross-correlation with each of the two inputs shows no significant
correlation.

You can try to improve the estimation results by estimating the model again
with more iterations and trying different search methods. For example, you
can use the model midproc as an initial guess for the next iterations:

midproci = pem(Zei,midproc, 'SearchMethod','1lm")
compare(Zvi,midproc,midproct)
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resid(zZv1, midproc1i)

The resulting plots show an improved fit of the simulated model output
to the validation data and a reduced correlation in the residuals. The
SearchMethod='1m' setting uses the Levenberg-Marquardt method for
iterative parameter estimation.

For more information about the SearchMethod field of the Algorithm model
property of linear models, see the corresponding reference page.

Estimating a Transfer Function with a Noise Model

This portion of the tutorial shows how to estimate a process model and include
a noise model in the estimation. Including a noise model typically improves
model prediction results but not necessarily the simulation results.

Use the following command to specify a first-order ARMA noise:

midproc2 = pem(Zel,midprocO, 'DisturbanceModel’, ‘armail')

Note You can type 'dist' instead of 'DisturbanceModel’'. Property names
are not case sensitive, and you only need to include the portion of the name
that uniquely identifies the property.

Compare the resulting model to the measured data and perform residual
analysis, as follows:

compare(Zvi,midproc2)

figure
resid(Zv1,midproc2)
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The following plot shows that the model output maintains reasonable
agreement with the validation-data output. Press Enter to view the
cross-correlation of the residuals with the second input.
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The next plot shows that adding a noise model produces uncorrelated
residuals: the top set of axes show that the autocorrelation values are inside
the confidence bounds. This indicates a more accurate model.
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Estimating Black-Box Polynomial Models

In this section...

“Model Orders for Estimating Polynomial Models” on page 6-42
“Estimating a Linear ARX Model” on page 6-43
“Estimating a State-Space Model” on page 6-46
“Estimating a Box-Jenkins Model” on page 6-49

“Comparing Model Output to Measured Output” on page 6-51

Model Orders for Estimating Polynomial Models

In this portion of the tutorial, you estimate several different types of
black-box, input-output polynomial models.

You must have already prepared your data, as described in “Preparing Data”
on page 6-4.

You can use the following previous results of estimated model orders to specify
the orders of the polynomial model:
¢ For the first input/output combination, use:

= Two poles, corresponding to n,=2 in the ARX model.

= One zero, corresponding to n,=2 in the ARX model.

= Delay of 5, corresponding to n,=5 samples (or 2.5 minutes) in the ARX
model.

® For the second input/output combination, use:
= One pole, corresponding to n,=1 in the ARX model.
= No zeros, corresponding to n,=1 in the ARX model.

= Delay of 10, corresponding to n,=10 samples (or 5 minutes) in the ARX
model.
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Estimating a Linear ARX Model

e “About ARX Models” on page 6-43

¢ “Estimating ARX Models Using arx” on page 6-43
e “Accessing Model Data” on page 6-45

¢ “Learn More” on page 6-46

About ARX Models
For a single-input/single-output system (SISO), the ARX model structure is:

¥y +ayt-D+...+a,,yt-n,) =
biut —ng)+...+ b pu(t —np —ny +1) +e(t)

¥(t) represents the output at time ¢, u(?) represents the input at time ¢, n, is
the number of poles, n, is the number of zeros plus 1, n,, is the number of
samples before the input affects output of the system (called the delay or dead
time of the model), and e(¢) is the white-noise disturbance.

The ARX model structure does not distinguish between the poles for
individual input/output paths: dividing the ARX equation by A, which
contains the poles, shows that A appears in the denominator for both inputs.
Therefore, you can set n, to the sum of the poles for each input/output pair,
which is equal to 3 in this case.

The System Identification Toolbox product estimates the parameters a; ...q,

and by ...b, using the data and the model orders you specify.

Estimating ARX Models Using arx

Use arx to compute the polynomial coefficients using the fast, noniterative
method arx:

marx = arx(Zel1,'na',3,'nb',[2 1],'nk',[5 10]);

present(marx) % Displays model parameters
% with uncertainty information
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MATLAB estimates the polynomials A, B1, and B2:

Discrete-time IDPOLY model: A(q)y(t) = B(q)u(t) + e(t)
A(q) =1 - 1.027 (+-0.02917) q~-1

+ 0.1675 (+-0.04214) q~-2

+ 0.01307 (+-0.02591) q~-3

1.86 (+-0.1896) gq~-5 - 1.608 (+-0.1894) gq~-6
1.612 (+-0.07417) g~-10

B1(q)
B2(q)

The uncertainty for each of the model parameters is computed to 1 standard
deviation and appears in parentheses next to each parameter value.

Tip Alternatively, you can use the following shorthand syntax and specify
model orders as a single vector:

marx = arx(Ze1,[3 2 1 5 10])
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Accessing Model Data

The model you estimated, marx, is a discrete-time idpoly object. To get the
properties of this model object, you can use the get function:

get(marx)
a: [1

-1.0266 0.1675 0.0131]
b:
C:
d:
f:

da:
db:
dc:
dd:
df:
na:
nb:
nec:
nd:
nf:
nk:
InitialState:
Name:

Ts:

InputName:
InputUnit:
OQutputName:
OQutputUnit:
TimeUnit:
ParameterVector:
PName:

CovarianceMatrix:

NoiseVariance:
InputDelay:
Algorithm:
EstimationInfo:
Notes:
UserData:

[2x11 double]
1

1

[2x1 double]
[0 0.0292 0.0421 0.0259]
[2x11 double]
0

0

[2x1 double]
3

[2 1]

0

0

[0 0]

[5 10]

"Auto’

0.5000

{2x1 cell}
{2x1 cell}
{'ProductionRate'}
{'mg/min"'}
‘min'

[6x1 double]
{}

[6x6 double]
2.7611

[2x1 double]
[1x1 struct]
[1x1 struct]
{}

[]
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You can access the information stored by these properties using dot notation.
For example, you can compute the discrete poles of the model by finding the
roots of the A polynomaial:

marx_poles=roots(marx.a)
marx_poles =
0.7953

0.2883
-0.0570

In this case, you access the A polynomial using marx.a.

The model marx describes system dynamics using three discrete poles.

Tip You can also use the zpkdata command to compute the poles of a model
directly.

Learn More

To learn more about estimating polynomial models, see the corresponding
sections in the System Identification Toolbox User’s Guide.

For more information about accessing model data, see the topic on extracting
numerical data from linear models in the System Identification Toolbox User’s
Guide.

Estimating a State-Space Model

* “About State-Space Models” on page 6-47
e “Estimating State-Space Models Using n4sid” on page 6-47
e “Learn More” on page 6-49
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About State-Space Models

The general state-space model structure is:

x(t+1) = Ax(¢) + Bu(t) + Ke(t)
(@) = Cx(t) + Du(t) + e(t)

y(t) represents the output at time ¢, u(t) represents the input at time ¢, x(¢) is
the state vector at time ¢, and e(?) is the white-noise disturbance.

You must specify a single integer as the model order (dimension of the state
vector) to estimate a state-space model. By default, the delay equals 1.

The System Identification Toolbox product estimates the state-space matrices
A, B, C, D, and K using the model order and the data you specify.

The state-space model structure is a good choice for quick estimation because
it contains only two parameters: n is the number of poles (the size of the A
matrix) and nk is the delay.

Estimating State-Space Models Using n4sid

Use the n4sid command to specify a range of model orders and evaluate the
performance of several state-space models (orders 2 to 8):

mn4sid = n4sid(Zel1,2:8,'nk',[5 10]);
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This command uses the fast, noniterative (subspace) method and opens the
following plot. You use this plot to decide which states provide a significant
relative contribution to the input/output behavior, and which states provide
the smallest contribution.

IR
File Edit ‘ew Insert Tools Desktop ‘Window Help
DEeEES|(KRaAaMm8|E(0
Select model arder in cormmand window.
o a—
Fed: Default Choice
iy} ar
sk}
=
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=
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The vertical axis is a relative measure of how much each state contributes to
the input/output behavior of the model (log of singular values of the covariance
matrix). The horizontal axis corresponds to the model order n. This plot
recommends n=3, indicated by a red rectangle.

To select this model order, type 3 in the MATLAB Command Window, and
press Enter.

By default, n4sid uses a free parameterization of the state-space form. To
estimate a canonical form instead, set the value of the SSParameterization
property to 'Canonical':

mCanonical = n4sid(Ze1,3,'nk',[5 10],...
'ssparameterization', 'canonical');
present(mCanonical) % Displays model properties
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Note When you examine the displayed properties, notice that the model
order is high. This high order occurs because the model uses additional states
to incorporate input delays.

Learn More

To learn more about estimating state-space models, see the corresponding
topic in the System Identification Toolbox User’s Guide.

Estimating a Box-Jenkins Model

e “About Box-Jenkins Models” on page 6-49
e “Estimating a BJ Model Using pem” on page 6-49

® “Learn More” on page 6-51

About Box-Jenkins Models

The general Box-Jenkins (BJ) structure is:

& B (@) C(g)
)= “CLy (t—nky)+—Lelt
y(t) i:1E(q)uz( n;)+D(q)e()

To estimate a BJ model, you need to specify the parameters n,, Ny Ny Mg,
and n,.

Whereas the ARX model structure does not distinguish between the poles
for individual input/output paths, the BJ model provides more flexibility in
modeling the poles and zeros of the disturbance separately from the poles
and zeros of the system dynamics.

Estimating a BJ Model Using pem

You can use pem to estimate the BJ model. pem is an iterative method and has
the following general syntax:

pem(data, 'na',na, 'nb',nb,'nc',nc, 'nd',nd, 'nf',nf, 'nk',nk)
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In this case, data is an iddata or idfrd object, and na, nb, nc, nd, nf, and
nk specify the model order.

To estimate the BJ model, type the following command in the MATLAB
Command Window:

mbj = pem(Ze1,'nf',[2 1],'nb',[2 1],"'nc’,1,'nd", 1, 'nk’,[5 10]);
present(mbj)

This command specifies nf=2, nb=2, nk=5 for the first input, and nf=nb=1 and
nk=10 for the second input.

Tip Alternatively, you can use the following shorthand syntax that specifies
the orders as a single vector:

mbj = bj(Zet,[2 1 112 15 10]);

bj 1s a version of pem that specifically estimates the BJ model structure.

MATLAB estimates the following polynomial coefficients:

Discrete-time IDPOLY model:

y(t) = [B(q)/F(qg)]Ju(t) + [C(q)/D(q)le(t)

B1(q) = 1.823(+-0.1792)q"-5 - 1.315(+-0.2368)q"-6

B2(q) = 1.791(+-0.06435)q"-10

C(q) =1 + 0.1066(+-0.04015)q"-1

D(q) =1 - 0.7453(+-0.027)q"-1

F1(q) =1 - 1.321(+-0.06939)g"-1 + 0.5911(+-0.05516)q"-2
F2(q) =1 - 0.8314(+-0.006445)q"-1

The uncertainty for each of the model parameters is computed to 1 standard
deviation and appears in parentheses next to each parameter value.

The polynomials C and D give the numerator and the denominator of the
noise model, respectively.
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Learn More

To learn more about estimating BJ models, see the corresponding topic in the
System Identification Toolbox User’s Guide.

Comparing Model Output to Measured Output

To compare the output of the ARX, state-space, and Box-Jenkins models to
the measured output, use the compare function:

compare(Zvi,marx,mn4sid,mbj)

compare plots the measured output in the validation data set against the
simulated output from the models. The input data from the validation data
set serves as input to the models.
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Measured Output and Simulated Outputs

To perform residual analysis on the ARX model, type the following command:

resid(Zv1i,marx)

Because the sample system has two inputs, there are two plots showing the

cross-correlation with the second input.

cross-correlation of the residuals with each input. Press Enter to view the
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To perform residual analysis on the state-space model, type the following
command:

resid(Zv1,mn4sid)

Finally, to perform residual analysis on the BJ model, type the following
command:

resid(Zv1i,mbj)

All three models simulate the output equally well and have uncorrelated
residuals. Therefore, choose the ARX model because it is the simplest of the
three input-output polynomial models and adequately captures the process
dynamics.
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Simulating and Predicting Model Output

In this section...

“Simulating the Model Output” on page 6-54
“Predicting the Future Output” on page 6-55

Simulating the Model Output

In this portion of the tutorial, you simulate the model output. You must
have already created the continuous-time model midproc2, as described in
“Estimating Continuous-Time Transfer Functions (Process Models)” on page
6-31.

Simulating the model output requires the following information:

¢ Input values to the model

e Initial conditions for the simulation (also called initial states)

For example, the following commands use the iddata and idinput commands
to construct an input data set, and use sim to simulate the model output:

o°

Create input for simulation

U = iddata([],idinput([200 2]),'Ts',0.5);

% Simulate the response setting initial conditions
% equal to zero

ysim_1 = sim(midproc2,U, 'InitialState', 'zero')

To match the simulated response of a model to the measured output for the
same input, compute the initial states corresponding to the measured data.
You can ensure that the simulated response of the model midproc2 provides
a good fit to the measured data Zv1 by using findstates(idmodel). The
following command estimates the initial states X0est from the data set Zv1:

XOest = findstates(midproc2,Zv1);

Next, simulate the model using the initial states estimated from the data:

Usim = Zv1.u; % Simulation input
ysim_2 = sim(midproc2,Usim, 'InitialState',XOest);



Simulating and Predicting Model Output

Compare the simulated and the measured output on a plot:

figure

plot([ysim_2, Zv1.y])
legend({'model output', 'measured'})
xlabel('time'), ylabel('Output')

The comparison of simulated and measured output is displayed in the

following figure.
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Predicting the Future Output

Many control-design applications require you

to predict the future outputs of

a dynamic system using the past input/output data.
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For example, use predict to predict the model response five steps ahead:

predict(midproc2,Zei,5)

The predicted output is displayed in the following figure.
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To compare the predicted output values with the measured output values,
use the following command:

compare(Zei,midproc2,5)

The third argument of compare specifies a five-step-ahead prediction, as
shown in the following figure.

Note When you do not specify a third argument, as in “Simulating the Model
Output” on page 6-54, compare assumes an infinite prediction horizon and
simulates the model output instead.
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Use pe to compute the prediction error Err between the predicted output of
midproc2 and the measured output. Then, plot the error spectrum on a Bode
plot.

[Err] = pe(midproc2,2Zvi);
bode(spa(Err,[],logspace(-2,2,200)),...
‘mode', 'same', 'sd',1,'fill"')

As shown in the following figure, the prediction errors are plotted with a
1-standard-deviation confidence interval. The errors are greater at high
frequencies because of the high-frequency nature of the disturbance.

Jrgwer I [=E

File Edit Miew Insert Tools Deskbop  Window  Help B

NEE&E KaaMs |08 =0

o Last plotted: Power spectrum for signal e@ProductionRate

Power

Frequency (rad/min)




Tutorial — Identifying
Nonlinear Black-Box
Models Using the GUI

e “About This Tutorial” on page 7-2

¢ “What Are Nonlinear Black-Box Models?” on page 7-4
e “Preparing Data” on page 7-9

¢ “Estimating Nonlinear ARX Models” on page 7-15

¢ “Estimating Hammerstein-Wiener Models” on page 7-28
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About This Tutorial

In this section...

“Objectives” on page 7-2

“Data Description” on page 7-2

Obijectives

Estimate and validate nonlinear models from single-input/single-output
(SISO) data to find the one that best represents your system dynamics.

After completing this tutorial, you will be able to accomplish the following
tasks using the System Identification Tool GUI:

® Import data objects from the MATLAB workspace into the GUI.
¢ Estimate and validate nonlinear models from the data.

¢ Plot and analyze the behavior of the nonlinearities.

Data Description

This tutorial uses the data file twotankdata.mat, which contains SISO
time-domain data for a two-tank system, shown in the following figure.

)

Tank 1

Tank 2

Two-Tank System



About This Tutorial

In the two-tank system, water pours through a pipe into Tank 1, drains into
Tank 2, and leaves the system through a small hole at the bottom of Tank
2. The measured input u(%) to the system is the voltage applied to the pump
that feeds the water into Tank 1 (in volts). The measured output y(?) is the
height of the water in the lower tank (in meters).

Based on Bernoulli’s law, which states that water flowing through a small
hole at the bottom of a tank depends nonlinearly on the level of the water in
the tank, you expect the relationship between the input and the output data

to be nonlinear.

twotankdata.mat includes 3000 samples with a sampling interval of 0.2 s.
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What Are Nonlinear Black-Box Models?

In this section...

“Types of Nonlinear Black-Box Models” on page 7-4
“What Is a Nonlinear ARX Model?” on page 7-4

“What Is a Hammerstein-Wiener Model?” on page 7-6

Types of Nonlinear Black-Box Models

You can estimate nonlinear discrete-time black-box models for both
single-output and multiple-output time-domain data. You can choose from
two types of nonlinear, black-box model structures:

e Nonlinear ARX models

¢ Hammerstein-Wiener models

Note You can estimate Hammerstein-Wiener black-box models from
input/output data only. These models do not support time-series data, where
there is no input.

To learn how to estimate nonlinear black-box models at the command line,
see the topics on estimating nonlinear models in the System Identification
Toolbox User’s Guide.

What Is a Nonlinear ARX Model?

This block diagram represents the structure of a nonlinear ARX model:



What Are Nonlinear Black-Box Models?

Nonlinearity Estimator

u Nonlinear
— ) > .
Regressors Function y
- u(t),u(t-1),y(t-1), ... I e
- "| Function

The nonlinear ARX model computes the output y in two stages:

1 Computes regressors from the current and past input values and past
output data.

In the simplest case, regressors are delayed inputs and outputs, such as

u(t-1) and y(t-3)—called standard regressors. You can also specify custom
regressors, which are nonlinear functions of delayed inputs and outputs.

For example, tan(u(¢-1)) or u(t-1)*y(¢-3).

By default, all regressors are inputs to both the linear and the nonlinear
function blocks of the nonlinearity estimator. You can choose a subset of
regressors as inputs to the nonlinear function block.

2 The nonlinearity estimator block maps the regressors to the model output
using a combination of nonlinear and linear functions. You can select from
available nonlinearity estimators, such as tree-partition networks, wavelet
networks, and multi-layer neural networks. You can also exclude either
the linear or the nonlinear function block from the nonlinearity estimator.

The nonlinearity estimator block can include linear and nonlinear blocks in
parallel. For example:

Fx) =L (x-r+d+g(Qx-r)
x is a vector of the regressors. LT (x)+d is the output of the linear function

block and is affine when d#0. d is a scalar offset. g(Q(x—r)) represents the
output of the nonlinear function block. r is the mean of the regressors x. @ is
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a projection matrix that makes the calculations well conditioned. The exact
form of F(x) depends on your choice of the nonlinearity estimator.

Estimating a nonlinear ARX model computes the model parameter values,
such as L, r, d, @, and other parameters specifying g. Resulting models are
idnlarx objects that store all model data, including model regressors and
parameters of the nonlinearity estimator. See the idnlarx reference page
for more information.

What Is a Hammerstein-Wiener Model?
This block diagram represents the structure of a Hammerstein-Wiener model:

u(t) Input | w(t) | Linear ] x(t) | Outout ) y(t)
——» Nonlinearity > Block » Nonlinearity —»
f B/F h

where:
* w(t) = f(u(t)) is a nonlinear function transforming input data u(t). w(t) has
the same dimension as u(t).

* x(t) = (B/F)w(t) is a linear transfer function. x(z) has the same dimension
as y(t).

where B and F are similar to polynomials in the linear Output-Error model,
as described in “What Are Black-Box Polynomial Models?”.

For ny outputs and nu inputs, the linear block is a transfer function matrix
containing entries:
Bji(@
Fji@
where j=1,2,...,nyandi=1,2,...,nu.
® y(t) = h(x(?)) is a nonlinear function that maps the output of the linear

block to the system output.

w(t) and x(t) are internal variables that define the input and output of the
linear block, respectively.
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Because f acts on the input port of the linear block, this function is called
the input nonlinearity. Similarly, because h acts on the output port of the
linear block, this function is called the output nonlinearity. If system contains
several inputs and outputs, you must define the functions f and A for each
input and output signal.

You do not have to include both the input and the output nonlinearity in the
model structure. When a model contains only the input nonlinearity f, it is
called a Hammerstein model. Similarly, when the model contains only the
output nonlinearity A), it is called a Wiener model.

The nonlinearities f and & are scalar functions, one nonlinear function for
each input and output channel.

The Hammerstein-Wiener model computes the output y in three stages:

1 Computes w(t) = f(u(t)) from the input data.
w(t) is an input to the linear transfer function B/F.

The input nonlinearity is a static (memoryless) function, where the value of
the output a given time ¢ depends only on the input value at time £.

You can configure the input nonlinearity as a sigmoid network, wavelet
network, saturation, dead zone, piecewise linear function, one-dimensional
polynomial, or a custom network. You can also remove the input
nonlinearity.

2 Computes the output of the linear block using w(t) and initial conditions:

x(t) = (B/F)w(?).

You can configure the linear block by specifying the numerator B and
denominator F orders.

3 Compute the model output by transforming the output of the linear block
x(t) using the nonlinear function A: y(f) = h(x(t)).

Similar to the input nonlinearity, the output nonlinearity is a static
function. Configure the output nonlinearity in the same way as the input
nonlinearity. You can also remove the output nonlinearity, such that y(¢) =

x(1).
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Resulting models are idnlhw objects that store all model data, including
model parameters and nonlinearity estimator. See the idnlhw reference page
for more information.
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Preparing Data

Preparing Data

In this section...
“Loading Data into the MATLAB Workspace” on page 7-9

“Creating iddata Objects” on page 7-9
“Starting the System Identification Tool” on page 7-11

“Importing Data Objects into the System Identification Tool” on page 7-12

Loading Data into the MATLAB Workspace

Load sample data in twotankdata.mat by typing the following command
in the MATLAB Command Window:

load twotankdata

This command loads the following two variables into the MATLAB Workspace
browser:

® yis the input data, which is the voltage applied to the pump that feeds the
water into Tank 1 (in volts).

® v is the output data, which is the water height in Tank 2 (in meters).

Creating iddata Objects

System Identification Toolbox data objects encapsulate both data values and
data properties into a single entity. You can use the System Identification
Toolbox commands to conveniently manipulate these data objects as single
entities.

You must have already loaded the sample data into the MATLAB workspace,
as described in “Loading Data into the MATLAB Workspace” on page 7-9.
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Use the following commands to create two iddata data objects, ze and zv,
where ze contains data for model estimation and zv contains data for model
validation. Ts is the sampling interval.

Ts = 0.2; % Sampling interval is 0.2 sec

z = iddata(y,u,Ts);

[)

ze =

[)

z(1:1000);

zv = z(1001:3000);

% First 1000 samples used for estimation

% Remaining samples used for validation

To view the properties of the iddata object, use the get command. For
example, type this command to get the properties of the estimation data:

get(ze)

MATLAB software returns the following data properties and values:

Domain: 'Time'
Name: []
OutputData: [1000x1 double]
y: 'Same as OutputData'’
OutputName: {'y1'}
OutputUnit: {''}
InputData: [1000x1 double]
u: 'Same as InputData’
InputName: {'ut1'}
InputUnit: {''}
Period: Inf
InterSample: 'zoh'
Ts: 0.2000
Tstart: 0.2000
SamplingInstants: [1000x0 double]
TimeUnit: "'
ExperimentName: 'Exp1’
Notes: []
UserData: []
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To modify data properties, use dot notation or the set command. For example,
to assign channel names and units that label plot axes, type the following
syntax in the MATLAB Command Window:

% Set time units to minutes
ze.TimeUnit = 'sec';

% Set names of input channels
ze.InputName = 'Voltage';

% Set units for input variables
ze.InputUnit = 'V';

% Set name of output channel
ze.OutputName = 'Height';

% Set unit of output channel
ze.OutputUnit = 'm';

% Set validation data properties
zv.TimeUnit = 'sec';
zv.InputName = 'Voltage';
zv.InputUnit 'V
zv.OutputName = 'Height';
zv.OutputUnit ‘m';

To verify that the InputName property of ze is changed, type the following
command:

ze.inputname

Tip Property names, such as InputName, are not case sensitive. You can also
abbreviate property names that start with Input or Output by substituting u
for Input and y for Output in the property name. For example, OutputUnit is
equivalent to yunit.

Starting the System Identification Tool

To open the System Identification Tool GUI, type the following command
in the MATLAB Command Window:

ident
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The default session name, Untitled, appears in the title bar.
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Ezxit I~ Moize spectrum
==t walidation Dats
Status line is here.

Importing Data Objects into the System Identification

Tool
You can import the data objects into the GUI from the MATLAB workspace.

You must have already created the data objects, as described in “Creating
iddata Objects” on page 7-9, and opened the GUI, as described in “Starting
the System Identification Tool” on page 7-11.

To import data objects:

1 In the System Identification Tool GUI, select Import data > Data object.

Import data j

Impart data
Titne dotmain data..
Freq. domain data. ..

Example...
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Preparing Data

This action opens the Import Data dialog box.

-iox

Data Format for Signals

[ibDATA or IDFRDIFRD -

Workspace Variable

Ohject: I
Ohject class:

Data Information
Data name: In‘[ydﬂtﬂ
Starting tirme: |1

Sampling interval: |1

More I

Import

| Reset |

Close

| Hep |

2 Enter ze in the Object field to import the estimation data. Press Enter.

This action enters the object information into the Import Data fields.

Click More to view additional information about this data, including
channel names and units.

3 Click Import to add the icon named ze to the System Identification Tool

GUL

4 In the Import Data dialog box, type zv in the Object field to import the

validation data. Press Enter.

5 Click Import to add the icon named zv to the System Identification Tool

GUL

6 In the Import Data dialog box, click Close.
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7 Tutorial - Identifying Nonlinear Black-Box Models Using the GUI

7 In the System Identification Tool GUI, drag the validation data zv icon to
the Validation Data rectangle. The estimation data ze icon is already
designated in the Working Data rectangle.

The System Identification Tool GUI now resembles the following figure.

) System Identification Tool - Untitled 10l =l
File Options Window Help

Ilmpurt data 'I Ilm|:|c|rt modelz 'I
“ Operations “

r ' I |<— Preprocess 'I
za v 1'

=

b=}
Working Data

I Estimate —= 'I

Drata Wiewws Model Views
To To
[~ Time piot Works pace| (LTI Viswsr| [™ [jodel gutput = Fransientresp [T Nonlinear ARX
[ Data spectra [~ | Model reside = Erequency resp [™ | Hamm-iener

[ Frequency function ”” Wﬁf‘}r [= | Zeros and poles
Exit | v [~ Noize =pectrum
Trash Validation Data .

Compiling ...
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Estimating Nonlinear ARX Models

Estimating Nonlinear ARX Models

In this section...
“Estimating a Nonlinear ARX Model with Default Settings” on page 7-15

“Plotting Nonlinearity Cross-Sections for Nonlinear ARX Models” on page
7-19

“Changing the Nonlinear ARX Model Structure” on page 7-22
“Selecting a Subset of Regressors in the Nonlinear Block” on page 7-25

“Specifying a Previously-Estimated Model with Different Nonlinearity”
on page 7-26

“Selecting the Best Model” on page 7-27

Estimating a Nonlinear ARX Model with Default
Settings

In this portion of the tutorial, you estimate a nonlinear ARX model using
default model structure and estimation options.

You must have already prepared the data, as described in “Preparing Data”

on page 7-9. For more information about nonlinear ARX models, see “What Is
a Nonlinear ARX Model?” on page 7-4
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7 Tutorial - Identifying Nonlinear Black-Box Models Using the GUI

1 In the System Identification Tool GUI, select Estimate > Nonlinear
models.

Estimate —= H L

Estimate —=

Linear parametric models...
Process models...

Spectral modelz... g

Correlation medels...
Cuick =tart

This action opens the Nonlinear Models dialog box.

_ioix

i Configure{ Estimate |

Model name: nlarxl

Mode! type: I Manlinear ARX LI Initialize... |
InpaLtt= (L) Monlinear Block
I Linear Black I
Regressors | Model Properties |

—
Quitputs ()
P ——

Spedify delay and number of terms in standard regressors for output Height:

Regressors Predicted

ud £, W30, 1),

Channel Name I Delay I Mo, of Terms I Resulting Regressors
Input Channels
Voltage 1 [ Voltage(t-1), Voltage (t-2)
Output Channels
Height [ 2 Height(t-1), Height(t-2)

Mote: Model has no custom regressars.

Infer Input Delay... | Edit Regressors. .. |

Estimate | Close | Help |

The Configure tab is already open and the default Model type is
Nonlinear ARX.
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Estimating Nonlinear ARX Models

In the Regressors tab, the Input Channels and Output Channels have
Delay set to 1 and No. of Terms set to 2. The model output y(?) is related
to the input u(t) via the following nonlinear autoregressive equation:

y@® = f (@ -1,y - 2),ult - 1),u(t - 2))

f is the nonlinearity estimator selected in the Nonlinearity drop-down
list of the Model Properties tab, and is Wavelet Network by default.
The number of units for the nonlinearity estimator is set to Select
automatically and controls the flexibility of the nonlinearity—more units
correspond to a more flexible nonlinearity.

Click Estimate.

This action adds the model nlarx1 to the System Identification Tool GUI,
as shown in the following figure.

<) System Identification Tool - ex_nlarx_data : - IDlzl
File ©Options wWindow Help

Ilmport data - l Ilmport models - l

l Operations ‘
r' v l" |<-- Preprocess vl \
ze v 1 nlarxd
=
ze
‘Working Data

Data Views Model Wiews
To To
I~ Time plat \Wiorkspace | |LTI Viewer [ 7 Model output I~ Transiert resp I~ Monlinesr ARX
[ Data spectra I Model resids [ Freguency resp [ Hamm-iener

[~ Freguency function l me [ Zeros and poles
Exit v .
—I Traszh [ Moise spectrum

Walidation Data
Model nlarx1 inzerted. Double click on icon (right mouse) for text information.
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7 Tutorial - Identifying Nonlinear Black-Box Models Using the GUI

The Nonlinear Models dialog box displays a summary of the estimation
information in the Estimate tab. The Fit (%) is the mean square error
between the measured data and the simulated output of the model: 100%
corresponds to a perfect fit (no error) and 0% to a model that is not capable
of explaining any of the variation of the output and only the mean level.

) Nonlinear Models =] E3

Configure Estimate I

B Estimation Trace ) )
Estimation Summary

Fit (%) = 87.29
FPE = 3.999e-005
| LossFen=3.654e-005

w Estimation Report

Estimation of Nonlinear ARX model: nlarx1

Estimation Data: 'ze' with 1000 samples.

Algorithm Options. .. |

Model Configuration:

Model regressors:Heightit-1), Height(t-2), Voltage(t-1), Voltage(t-2).
Regressors subset used for nonlinear block: All regressors.

Nonlinearity: Wervelet network with number of units chosen autormatically.

Estimation Progress:

Perfonming estimation with Focus = Prediction. ...
done.
Completed in 1 25 seconds.

Model Refinement
Last estimated model: nlarx1
[ Use last estimated madel as initial model For next estimation

I™ | Randaomize initial mode! befare estimation

Estimate || Clase i Help

Note Fit (%) is computed using the estimation data set, and not the
validation data set. However, the model output plot in the next step
compares the fit to the validation data set.

3 In the System Identification Tool GUI, select the Model output check box.
This action simulates the model using the input validation data as input to

the model and plots the simulated output on top of the output validation
data.
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Estimating Nonlinear ARX Models

=} Model Dutput: Height =]
File Options Style Channel Help

Measured and simulated model autput
0.6

BestFits

Hlarat: 60.91
0.4t

0.2t

-0.2F

-0.4 - : -
200 300 400 500 60O

Tirre

The Best Fits area of the Model Output plot shows that the agreement
between the model output and the validation-data output.

Plotting Nonlinearity Cross-Sections for Nonlinear
ARX Models

Perform the following procedure to view the shape of the nonlinearity as a
function of regressors on a Nonlinear ARX Model plot.
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7-20

1 In the System Identification Tool GUI, select the Nonlinear ARX check
box to view the nonlinearity cross-sections.

By default, the plot shows the relationship between the output regressors
Height(t-1) and Height(t-2). This plot shows a regular plane in the
following figure. Thus, the relationship between the regressors and the
output is approximately a linear plane.

) Monlinear ARE Model Plot _ (O] x|

File Options Style Help

Select nonlinearity at output: IHeight - I il

Qutput: Height

Output:Height

Regressar 1:

|I:| nlarx 1 wavenet | IHeigHt(t-ﬂ d

Range: [-0.045354 0%

Regressor 2:

[Heightit-2) =

Range: I—D.D45354 0
Remaining regressors:

Fix Yalues... |
Apply |

Maonlin

Reg 2 05 .05 Reg 1




Estimating Nonlinear ARX Models

2 In the Nonlinear ARX Model Plot window, set Regressor 1 to
Voltage(t-1). Set Regressor 2 to Voltage(t-2). Click Apply.

The relationship between these regressors and the output is nonlinear, as

shown in the following plot.

<)} Monlinear AR Model Plot [ (O] x|

File Options  Style Help

Select nonlinearity at output:

IHeight - I

TNOnTm

Output:Height

| [T nlarxtwavenet |

0o Reg 1

il

Qutput: Height

Regressar 1:

|Vo|tage(1.1 ] |

Range:  [1-2 1048]

Regressor 2:

[ataget-2) -

Range: 12 10.8]

Remaining regressors:

Fix values... |

3 To rotate the nonlinearity surface, select Style > Rotate 3D and drag

the plot to a new orientation.

4 To display a 1-D cross-section for Regressor 1, set Regressor 2 to none,
and click Apply. The following figure shows the resulting nonlinearity
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7 Tutorial - Identifying Nonlinear Black-Box Models Using the GUI

magnitude for Regressor 1, which represents the time-shifted voltage
signal, Voltage(t-1).

<} Monlinear AR Model Plot [ [O] x|
File Cptions  Style Help
Select nonlinearity at output: IHeight - I il
Outpart: Height
Output:Height |
0.297 T T : : Regrezsar 1
| nlars] wavenet | |Vn:ltage(t-1) j
0.296 7 Renge:  [12 1041
Regressor 2:
0295+ B
|<none> j
_ 0294| | Range:  [25¢ 0.63404]
= |
2 Remaining regressors:
0,293 - b
Fix Yalues... |
0292+ B
0.291 B
029 1 1 1 1 1
] 2 4 B 8 10 12
Reg 1

Changing the Nonlinear ARX Model Structure

In this portion of the tutorial, you estimate a nonlinear ARX model with
specific input delay and nonlinearity settings. Typically, you select model
orders by trial and error until you get a model that produces an accurate fit
to the data.

You must have already estimated the nonlinear ARX model with default
settings, as described in “Estimating a Nonlinear ARX Model with Default
Settings” on page 7-15.

1 In the Nonlinear Models dialog box, click the Configure tab, and click
the Regressors tab.
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Estimating Nonlinear ARX Models

2 For the Voltage input channel, double-click the corresponding Delay cell,
enter 3, and press Enter.

This action updates the Resulting Regressors list to show Voltage(t-3)
and Voltage (t-4)—terms with a minimum input delay of three samples.

3 Click Estimate.

This action adds the model nlarx2 to the System Identification Tool
GUI and updates the Model Output window to include this model. The
Nonlinear Models dialog box displays the new estimation information in
the Estimate tab.

<} Model Output: Height M=] E3
File Options Style Channel Help

Measured and simulated model output

0.6
BestFits

nlar2: 85.36
nlant: 60.91

0.4+

0.2t

-0zt

-04 : : :
0 300 400 500 60O

Tirme

4 In the Nonlinear Models dialog box, click the Configure tab, and select
the Model Properties tab.

5 In the Number of units in nonlinear block area, select Enter, and type
6. This number controls the flexibility of the nonlinearity.
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Regressors Model Properties

Monlinearity: | Wavelet Network LI ¥ Indude linear block

Properties of Wavelet Network
Mumber of units in nonlinear block:
™ Select automatically

{* Enter: |6|

{~ Selectinteractively during estimation

Advanced. .. |

6 Click Estimate.

This action adds the model nlarx3 to the System Identification Tool GUI.
It also updates the Model Output window, as shown in the following figure.

<} Model Output: Height M=] E3
File Options Style Channel Help

Measured and simulated model output

BestFits
nlardd: 86.28
nlark2: 85.36
nlarsl: 60.91

-04 : : :
0 300 400 500 60O

Tirme
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Estimating Nonlinear ARX Models

Selecting a Subset of Regressors in the Nonlinear
Block

You can estimate a nonlinear ARX model that includes only a subset of
standard regressors that enter as inputs to the nonlinear block. By default,

all standard and custom regressors are used in the nonlinear block. In this
portion of the tutorial, you only include standard regressors.

You must have already specified the model structure, as described in
“Changing the Nonlinear ARX Model Structure” on page 7-22.

1 In the Nonlinear Models dialog box, click the Configure tab, and select
the Regressors tab.

2 Click the Edit Regressors button to open the Model Regressors dialog box.

) Model Regressors x|

Qutput: Height

Monlingarity: Wavelet Metwork

~Regressor Creation and Selection

Select how to include regressors in the nonlinear block:

Al -

w Standard Regressors

Regressor Use in nonlinear block?
Height(t-1) Ird
Height(t-2) Ird
Valkage(t-3) v
Voltage(t-4) v

3 Clear the following check boxes:
e Height(t-2)
¢ Voltage(t-3)

Click OK.

This action excludes the time-shifted Height(t-2) and Voltage(t-3) from
the list of inputs to the nonlinear block.
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7 Tutorial - Identifying Nonlinear Black-Box Models Using the GUI

4 Click Estimate.

This action adds the model nlarx4 to the System Identification Tool GUI.
It also updates the Model Output window.

Specifying a Previously-Estimated Model with
Different Nonlinearity

You can estimate a series of nonlinear ARX models by making systematic
variations to the model structure and base each new model on the
configuration of a previously estimated model. In this portion of the tutorial,
you estimate a nonlinear ARX model that is similar to an existing model
(nlarx3), but with a different nonlinearity.

1 In the Nonlinear Models dialog box, select the Configure tab. Click
Initialize. This action opens the Initial Model Specification dialog box.

2 In the Initial Model list, select nlarx3. Click OK.

Initial Model Specification |

Initialize model properties using an existing model (optional):

Initial Model: | nlarx3 LI

nlarx4

- nlarx1
Nonlinear & iopyo

Input
Qutput name:

3 Click the Model Properties tab.
4 In the Nonlinearity list, select Sigmoid Network.

5 In the Number of units in nonlinear block field, type 6.

Regressors Model Properties I

Monlinearity: I Sigmoid Metwork j [+ Indude linear block

Properties of Sigmoid Metwork:

Mumber of units in nonlinear block: |5|
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6 Click Estimate.

This action adds the model nlarx5 to the System Identification Tool GUI.
It also updates the Model Output plot, as shown in the following figure.

) Model Output: Height ] m]
File Options Style Channel Help
Measured and simulated model output
(]
Best Fits
4
045
I nlarx3: 86.28
1
| ]‘ nlarn?: 85.36
o2r¢ B
r ‘, I nlard: 68,0621
" nlarx: 60.91
o E
-0.2 B
0.4 " L "
200 300 400 500 G600

Time

Selecting the Best Model

The best model is the simplest model that accurately describes the
dynamics. In this tutorial, the best model fit was produced in “Specifying a
Previously-Estimated Model with Different Nonlinearity” on page 7-26.

To view information about this model, including the model order, nonlinearity,
and list of regressors, right-click the model icon in the System Identification

Tool GUI.
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7 Tuiorial - Identifying Nonlinear Black-Box Models Using the GUI

Estimating Hammerstein-Wiener Models

In this section...

“Estimating Hammerstein-Wiener Models with Default Settings” on page
7-28

“Plotting the Nonlinearities and Linear Transfer Function” on page 7-31
“Changing the Hammerstein-Wiener Model Input Delay” on page 7-35

“Changing the Nonlinearity Estimator in a Hammerstein-Wiener Model”
on page 7-36

“Selecting the Best Model” on page 7-39

Estimating Hammerstein-Wiener Models with Default
Settings

In this portion of the tutorial, you estimate nonlinear Hammerstein-Wiener
models using default model structure and estimation options.

You must have already prepared the data, as described in “Preparing Data”
on page 7-9. For more information about nonlinear ARX models, see “What Is
a Hammerstein-Wiener Model?” on page 7-6

1 In the System Identification Tool GUI, select Estimate > Nonlinear
models to open the Nonlinear Models dialog box.

2 In the Configure tab, select Hammerstein-Wiener in the Model type list.
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Estimating Hammerstein-Wiener Models

) Nonlinear Models _ (O] x|

Configure | Estimate |

Madel name: rlhwi

Model bype:

Initialize. .. |
t t
£>| Input Manlinearity |—>| Linear Black }—>|Output Nonlinearﬂy}ﬂb

Hammerstein-Wiener model

1/ Monlinzarity I Linear Blockl

I Channel Mames I Manlinearity | Ma. of Units I

Input Channels

Waltage |Piecewise Linzar |1CI | Initial Value. .. I

Output Channels

Height |Piecewise Linzar |10 | Initial Value. .. I
Estimate | Close | Help |

The I/O Nonlinearity tab is open. The default nonlinearity estimator
is Piecewise Linear with 10 units for Input Channels and Output
Channels, which corresponds to 10 breakpoints for the piecewise linear
function.
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3 Select the Linear Block tab to view the model orders and input delay.

). Nonlinear Models _ (O] x|

Configure | Estimate |

Maodel name: rlhwi

(W00 M| Hammer skein-Wiener Initialize. .. |
u, 1
uit) . - L
Input Monlinesarity Linear Block Cutput Monlinesarity

Linear equatian: v (1) = (B/F)u it-n,)

1j0 Nonlinearity  Linear Black I
~Model Order

Input B Order (Zeras) F Order{Polzs) Input Delay (nk)

()
(]
—

Voltage

Infer Input Delay...

Estimate | Close | Help |

By default, the model orders and delay of the linear output-error (OE)
model are n,=2, n=3, and n,=1.

4 Click Estimate.

This action adds the model n1hw1 to the System Identification Tool GUI.
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5 In the System Identification Tool GUI, select the Model output check box.

This action simulates the model using the input validation data as input to
the model and plots the simulated output on top of the output validation
data.

The Best Fits area of the Model Output window shows the agreement
between the model output and the validation-data output.

Plotting the Nonlinearities and Linear Transfer

Function
You can plot the input/output nonlinearities and the linear transfer function
of the model on a Hammerstein-Wiener plot.
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1 In the System Identification Tool GUI, select the Hamm-Wiener check
box to view the Hammerstein-Wiener model plot.

The plot displays the input nonlinearity, as shown in the following figure.

) Hammerstein-Wiener Model Plot iy [ m] 4|

File Options 5Style Help
>|

Click on a hlock to view its plot:

— e o }—
Select nonlinearity at channel: I‘\.furtﬂge - I

nlhw:pwlinear

Nonlinearity Value

_ﬁ L L L
0 2 4 6 8 10 12

Input to nenlinearity at input Voltage'
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Estimating Hammerstein-Wiener Models

2 Click the yy;, rectangle in the top portion of the Hammerstein-Wiener
Model Plot window.

The plot updates to display the output nonlinearity.

) Hammerstein-Wiener Model Plot iy [ m] 4|

File Options 5tyle Help

[
Click on a hlock to view its plot: 3'
o ok | —
Select nonlinearity st channel: IHeight - I
0.5 T T T T I
| nlhw:pwlinear
0.4 B
0.3r B
g
= 02r E
=
-'E' 01 B
g
=
5 o -
=
01 B
021 B
_0-3 L L L L L
-1500 -1000 -500 0 500 1000 1500
Input to nonlinearity at output 'Height'
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3 Click the Linear Block rectangle in the top portion of the
Hammerstein-Wiener Model Plot window.

The plot updates to display the step response of the linear transfer function.

) Hammerstein-Wiener Model Plot i [ m] 4|

File Options 5Style Help

[
Click on a hlock to view its plot: 3'

UnL YL

Select IO pair: I\.-fultage—>Height j Choose plot type:  ESEY H

To Height
2000 T T

nlhw1
7000 E

From Voltage
I w I <)) @
[=] [=) [=) [=] [=]
[=] = = = =]
[=] [=) [=) [=) [=)
1

1000 - -

u L 1 1 L L
4000 2000 0 2000 4000 6000 2000 10000
Time (sec)
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4 In the Choose plot type list, select Bode. This action displays a Bode
plot of the linear transfer function.

.} Hammerstein-Wiener Model Plot ] 4|

File Options Style Help
>l

Click on a block to view its plot:

—— Uy |—nearBlock|— vy, |—
Select 100 pair: I\.-‘Ultage->Height j Choose plot type:
o° From Voltage To Height
m
-g o
£ 10 | .
E
<
13’5 I I I I I
— 0 T
g
g
= -100F E
[k}
!
=
n‘ _203 1 1 1 1 1
1g* 1g° 162 107 10 10' 10°
Frequency (rad/sec)

Changing the Hammerstein-Wiener Model Input
Delay

In this portion of the tutorial, you estimate a Hammerstein-Wiener model
with a specific model order and nonlinearity settings. Typically, you select
model orders and delays by trial and error until you get a model that produces
a satisfactory fit to the data.

You must have already estimated the Hammerstein-Wiener model with
default settings, as described in “Estimating Hammerstein-Wiener Models

with Default Settings” on page 7-28.
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1 In the Nonlinear Models dialog box, click the Configure tab, and select
the Linear Block tab.

2 For the Voltage input channel, double-click the corresponding Input
Delay (nk) cell, change the value to 3, and press Enter.

3 Click Estimate.

This action adds the model n1hw2 to the System Identification Tool GUI
and the Model Output window is updated to include this model, as shown
in the following figure.

=) Model Output: Height ] [m]
File Options Style Channel Help
Measured and simulated model output
06 .
Best Fits
05 , 4 Inlhw2:75.6
nlhw1: 36.08
0.4
0.3
0.2
0.1
4]
_01 1 1 L
200 300 400 500 800
Tirme

The Best Fits area of the Model Output window shows the quality of the
nlhw2 fit.

Changing the Nonlinearity Estimator in a
Hammerstein-Wiener Model

In this portion of the example, you modify the default Hammerstein-Wiener
model structure by changing its nonlinearity estimator.
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Tip If you know that your system includes saturation or dead-zone
nonlinearities, you can specify these specialized nonlinearity estimators
in your model. Piecewise Linear and Sigmoid Network are nonlinearity
estimators for general nonlinearity approximation.

1 In the Nonlinear Models dialog box, click the Configure tab, and click
the Linear Block tab.

2 In the I/O Nonlinearity tab, for the Voltage input, click the Nonlinearity
cell, and select Sigmoid Network from the list. Click the corresponding No.
of Units cell and set the value to 20.

| Channel Mames | Monlinearity: I Mo, of Units I
Input Channels
"oltage Piecewise Linear j 0 | Initial Walue, .. I
Qutput Channels Piecewise Linear
Height 10 | Initial Walue. .. I
Saturation
Dead Zone
Wavelet Network
Mone

3 Click Estimate.

This action adds the model n1hw3 to the System Identification Tool GUI. It
also updates the Model Output window, as shown in the following figure.

7-37



7 Tutorial - Identifying Nonlinear Black-Box Models Using the GUI

7-38
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File Options Style Channel Help
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4 In the Nonlinear Models dialog box, click the Configure tab.

5 In the I/O Nonlinearity tab, set the Voltage input Nonlinearity to
Wavelet Network. This action sets the No. of Units to be determined
automatically, by default.

6 Set the Height output Nonlinearity to One-dimensional Polynomial.

1/O Nonlinearity | Linear Black |

Channel Mames I Manlinearity | Ma. of Units I
Input Channels
Voltage |"."'.n'a'-.-'elet Metwork |Select automati... | Advanced. .. I
Qutput Channels
Height |One-dimensi0nal Palynomial |2 | Initial value... I
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7 Click Estimate.

This action adds the model n1hw4 to the System Identification Tool GUI. It
also updates the Model Output window, as shown in the following figure.

) Model Output: Height ] m|

File Options Style Channel Help

Measured and simulated model output

06 :
Best Fits
05 f nlhwed: 90.87
nlhw3: 89.22
04
nlhwz2: 756
03} nlhwe1: 36.06
02}
01y
D L
_D‘I 1 ! 1
200 300 400 500 600

Selecting the Best Model

The best model is the simplest model that accurately describes the dynamics.

In this example, the best model fit was produced in “Changing the
Nonlinearity Estimator in a Hammerstein-Wiener Model” on page 7-36.
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